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Introduction
Geomatica I

Welcome to Geomatica I, an introductory course using Geomatica’s Focus 
technology. This guide is written for new and experienced users of geospatial 
software. In this course you will master the basics needed to visualize and 
process raster and vector datasets.

This manual contains five modules. Each module contains lessons that are 
built on basic tasks that you are likely to perform in your daily work. They 
provide instruction for using the software to carry out essential processes in 
Geomatica Focus.

Please note that training for OrthoEngine is not included in this guide. If you 
require more information about OrthoEngine training, please go to the PCI 
Geomatics Training Department website: http://www.pcigeomatics.com/
services/training/index.html.

About this 
Training Guide

The scope of this guide is confined to Geomatica Focus; however, some 
remote sensing concepts are reviewed in the modules and lessons.

The following modules are included in this course:

• Module 1 - Image Display and Viewing

• Module 2 - Working with Image Data

• Module 3 - Image Processing with Focus

• Module 4 - Image Processing with the Algorithm Librarian

• Module 5 - Vector Processing

Each module in this book contains a series of hands-on lessons that let you 
work with the software and a set of sample data. Lessons have brief 
introductions followed by tasks and procedures in numbered steps.

The data you will use in this course can be found in the GEO Data folder 
supplied on the accompanying CD. You should copy this data to your hard 
disk.

Students who are unfamiliar with the file structure of geospatial data should 
carefully review the remaining sections in this introduction before moving on to 
the course work in the modules.
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Geospatial Data Structures

Data for the geospatial applications are stored in complex files that are often 
incompatible with specific software packages and operating systems. Files can 
come in hundreds of different formats and in most geospatial applications often 
require considerable preparation or preprocessing before they can be combined in 
a work project.

Most geospatial formats store image data in one file and supplementary data, such 
as bitmaps, vector layer and metadata, in another file using different file extensions 
for each data type. Updating and maintaining complex datasets made up of many 
file types can be a difficult and error-prone process.

PCI Geomatics has developed two unique technologies that make data 
management easier: GeoGateway and the PCIDSK file format. The following 
sections explain how GeoGateway technology and the PCIDSK format work in 
Geomatica to make your data management easier.

GeoGateway Technology in Geomatica

GeoGateway, also known as Generic Database (GDB) technology, is key to 
Geomatica applications. GeoGateway makes it possible to view and integrate 
geospatial data from more image formats than any other geomatics software. It 
allows you to use as much data as you require in your work and to combine images 
of any data type, resolution, and size. You can use image files, with their 
accompanying metadata, in the same georeferenced viewer even after combining 
various file formats and data types.

The list of file formats that GeoGateway uses is constantly under development. 
Currently there are more than 130 usable geospatial file types. Many popular 
formats such as ARC/INFO, GeoTIFF, AutoCAD, and MicroStation are fully 
supported. New and emerging standards such as JPEG2000 are also supported in 
Geomatica.

GeoGateway operates behind the scenes in Geomatica applications. The 
illustration below shows a file selection window for Geomatica Focus. When you 
click the Files of type box, you can see the list of file formats that can be opened 
directly into a Geomatica application.
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Figure 1      
GeoGateway in 
Geomatica

With GeoGateway technology you can work through a mapping project by 
assembling raster and vector data from different sources and different file formats 
without having to preprocess or reformat the data. Together, GeoGateway and 
Geomatica read, view, and process distribution formats, and read, edit, and write 
exchange formats.

PCIDSK and Geomatica

PCIDSK files contain all of the features of a conventional database and more. They 
store a variety of data types in a compound file that uses a single file name 
extension. The image data are stored as channels and auxiliary data are stored as 
segments. All data types are stored together in the file using .pix as the file name 
extension. The data type and format of the component determines whether 
searching, sorting and recombining operations can be performed with the software 
application tools.

In PCIDSK files, images and associated data, called segments, are stored in a single 
file making it easier to keep track of imagery and auxiliary information.

PCIDSK File Format

Using a single file for each set of data simplifies basic computing operations. Since 
all data is part of the same file you can add or remove parts of it without having to 
locate, open, and rename more files.

PCIDSK files are identical in all operating environments and can be used on 
networked systems without the need to reformat the data.
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Figure 2      
Conventional files and 
PCIDSK files

PCIDSK Files      Conventional Files

Working with Geomatica Focus

Geomatica Focus is designed to work with dozens of data formats, through 
GeoGateway, and to take advantage of the PCIDSK file format.

When you start Geomatica on your system desktop, the Geomatica Toolbar opens 
and the Focus application starts automatically. The Geomatica toolbar includes a 
button for each of the major Geomatica applications: Focus, OrthoEngine, 
Modeler, FLY!, and others.

Figure 3                           
Geomatica Toolbar

When you pass your mouse over a button on the toolbar the name of the application 
appears as a ToolTip beside your mouse pointer. The illustration below shows the 
basic parts of the Focus window.

Image Files

Training site files 

Histogram files

Image channels

Training site segments

Histogram segments

Saved Separately using differentSaved as a single DSK file using the file name
file name extensionsextension .pix 
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Figure 4                           
Focus window

Managing Data in Focus

In Figure 5 you can see what Focus looks like with an open PCIDSK file. On the 
right, in the Focus view area, you can see the file imagery. On the left you can see 
both image and auxiliary data as channels and segments in the Maps and Files trees. 
The color channels are separated into red, green, and blue layers and show the 
electromagnetic spectrum (EMS) frequency range for the source image.

The Maps Tree The Maps tree lists the areas, layers, channels, and segments that make up the 
image in the view area. The Maps tree components are stored in your system 
memory.

It contains layers that can be shown in the Focus view area, including the channels 
that make up the layers and any results from algorithms that are stored in system 
memory. Items appearing in the Maps tree are not necessarily data saved on a hard 
disk and they do not effect the original data files.

B

A

E

A. Menu bar B. Toolbar C. Maps and Files tree tabs D. Work area E. View area F. Status bar

F

C

D
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Figure 5                             
Maps tree

Note
Channels, segments, and layers, appearing in the Focus Maps tree, are stored 
in your system memory.

The Files Tree Both the Maps and the Files tree provide a way to browse and manage and manage 
your data.

Figure 6 shows the entire contents of a PIX file, grouped by data type, in the Focus 
Files tree.
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Figure 6                          
Files tree

You can show or hide the vector and bitmap segments, listed in the Files tree, in 
the Focus view area. Like the PCIDSK format, Geomatica Focus keeps image 
channels and auxiliary data segments in the same place.

Note
The data listed in the Files tree is stored in the source file on your system hard 
disk.

Some of the data types, listed in the Files tree, are not viewable as image 
components. The same list can contain other auxiliary data types such as lookup 
tables (LUT), pseudo-color tables (PCT), and signatures. You use the Focus 
software tools and dialog boxes to work with these data types.

Working with Geomatica Project Files 

Focus project files (.gpr files) provide a way for you to organize data for complex 
projects in one large file. A .gpr file not only stores Maps, Areas, and Layers but 
also includes all path information to data, viewing preferences, such as the last 
zoom level you worked at, and all associated Map elements. A .gpr file can also 
include multiple Maps, Areas, and all associated Layers.
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Understanding Maps, Areas, Layers, and Segments

The files, listed in the Maps tree, are a hierarchy of elements that make up a 
Geomatica project. Maps tree elements have common properties that you can 
control from the Maps and Files trees, the menu bar, and context-sensitive 
shortcuts.

Maps The element at the top of the hierarchy is the Map. This is the workspace that holds 
all of the data for your work. You can have more than one map in a project. The 
Map is also a page that contains the extents of your project canvas. You can adjust 
the map size to control the size of your printed output. When Focus is in Map View 
mode, you can adjust the size and position of the image relative to the canvas. You 
can also add surround elements to your map.

Areas The Area element holds the file boundaries for either image or vector layers. Areas 
can include multiple layers and segments for a geographical region and you can 
have as many areas in a project as you wish. Each Area has a unique georeferencing 
system. When new image files are added to an area they are referenced 
automatically.

Layers Layers hold the data that is displayed in the view area. Made up of segments, layers 
can be rearranged in the Maps tree to vary the image in the view area. You change 
the order of layers by dragging them up or down the Maps tree. When you move a 
layer, you move the segments that belong to it as well.

Segments Segments are all of the components that make up a layer. For example, channels, 
vectors, bitmaps, and look-up tables (LUT) can all be considered as segments when 
they appear as part of a layer.

Starting Your Work

In the lessons that follow, you will have an opportunity to carry out several tasks 
using Focus. Your overall goal is to become familiar with the software and to see 
how you can use Geomatica in your own work.
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Module

 1 
Visualizing Image Data

Module 1 has Four Lessons:

Lesson 1.1     Viewing and Managing Layers

Lesson 1.2     Using the Zoom and Pan Tools

Lesson 1.3     Using Visualization Tools

Lesson 1.4     Using Measure Tools

Viewing Data Geomatica Focus is one of the most interactive software programs on the 
market today for working with spatial data. A major strength of Focus is its 
ability to easily view and navigate your databases.

When you work with Focus, the Maps tree lists the areas, layers, and 
segments that make up the image in the view area. Layers and segments 
appearing in the Focus Maps tree are stored in your system memory. You can 
show or hide the items in the Maps tree by clicking the check box to the left of 
the item you want. You can also change the priority of a layer by dragging it up 
or down in the Maps tree. The goal is to make data viewing as efficient as 
possible.

In Module 1, many of the features in Focus for viewing your data including 
adding and managing layers, using zoom tools, measure tools and 
visualization tools are discussed. At the end of this module, you will be able to 
successfully navigate the Focus interface with your data.
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Lesson 1.1 Viewing and Managing Layers

In this lesson you will:

• Open different types of layers

• Use Map View Mode and Area View Mode

• Manage layer properties

• View file properties

Color 
Composite 
Images

Multispectral sensors acquire data from different portions of the electromagnetic 
spectrum which is stored in channels, or bands. A color composite is created by 
displaying three different bands of data using the red, green and blue (RGB) color 
guns or display channels. The DN (digital number) of each pixel in each channel 
represents a brightness value for the RGB components of the color composite. 
Color composites are important for effective visual interpretation of multispectral 
imagery. The order in which channels are placed in the color composite depends 
on which feature(s) you want to enhance in the image. For example, in a 4, 3, 2 
Landsat 7 false color composite, healthy vegetation will be red and urban areas will 
be cyan, making the distinction between these two classes quite clear.

To begin this lesson, you will open the Geomatica Toolbar and a Focus window.

Starting Geomatica

Windows 
Systems

To start Geomatica on Windows systems:
1. Click the Start menu and select Programs.
2. From the Programs list, select PCI Geomatics, then Geomatica Vx.x, then 

Geomatica.
The Geomatica Toolbar and a Focus window open.

Unix Systems To start Geomatica on Unix systems:
1. Enter the Unix environment.
2. At the command prompt, type geomatica.

The Geomatica Toolbar and a Focus window open.

Figure 1.1                      
Geomatica toolbar
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To open an image file in Focus:
1. From the Focus File menu, click Open.

A File Selection window opens.

2. In the Geomatica program folder, locate and open the GEO Data folder.
3. Click toronto_l7.pix.

4. Click Open.
By default, the first three image channels of the toronto_l7.pix file are 
automatically loaded as a color composite in the Focus view area and an RGB 
Layer is listed in the Maps tree.

Note
If the file you open has less than three raster layers, the first layer is displayed 
as a single grayscale layer. If it does not have raster data, the first vector layer 
is displayed.

Figure 1.2                               
toronto_l7.pix RGB Layer 

5. Click in the Focus view area.
The cursor moves to this position in the image. The DN values of the red, 
green, and blue layers for the pixel identified by the cursor position are 
displayed on the status bar.
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Figure 1.3                   
RGB values in the Status 
Bar

Focus lets you map channels of data to different display channels to view different 
band combinations. The RGB Mapping dialog box lets you change or map the 
channel data to a color display channel and show the changes in the view area.

To change the band combination for an RGB Layer:
1. From the Layer menu, select  RGB Mapper.

The RGB Mapper opens.

Figure 1.4                     
The RGB Mapper

2. In the RGB Mapper dialog box, click in the columns to display Band 1 in 
Blue, Band 2 in Green and Band 3 in Red.

3. Click Close.
A true color composite is displayed in the Focus view area.

Note
Changing band combinations cancels enhancements you have applied. To 
maintain an enhancement, you must enhance the image again.

4. On the Focus toolbar, click the Enhancements button.
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Figure 1.5       
Enhancing the True Color 
Composite

The image enhancement is reapplied to the true color composite. 
Enhancements will be described further in Lesson 3.1.

Grayscale 
Images

Panchromatic sensors collect data in a broad region of the electromagnetic 
spectrum and store this data in one channel, or band.  Multispectral sensors detect 
energy from specific wavelength ranges and store this information in several 
channels. In either case, when viewing a single channel, it is visualized as a 
grayscale image. For grayscale images, the computer displays each digital number 
(DN) as a different brightness level of gray.

To load a grayscale layer using the Add Layer Wizard:
1. From the Layer menu, select Add.

The Add Layer Wizard opens.

Figure 1.6                     
Add Layer Wizard

2. From the list of layer types to add, select Grayscale.
3. Click Next.

The next step of the Add Layer Wizard is displayed.

4. Click Browse.
5. From the GEO Data folder, select the toronto_spot.pix file.
6. Click Open.
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The toronto_spot.pix file appears in the list of available files. One channel is 
shown in the available channels list.

7. From the available channels list, select the Panchromatic Band.
8. Click Finish.

The Add Layer wizard closes and the grayscale image is displayed on top of 
the RGB layer in the Focus view area. A grayscale layer is listed in the Maps 
tree.

Pseudo-Color 
Images

Single channels can be visualized with color by assigning a psuedo-color table 
(PCT) to a grayscale image.  In a psuedo-color image, each DN is assigned a red, 
green and blue (RGB) value. Often, more information can be visually extracted 
from a PCT image compared to a grayscale image.  This is because in general, the 
human eye can only detect 16-32 shades of grey, but can distinguish between 
roughly 2 000 000 colors.

When a file is loaded into Focus, a default layer is displayed in the view area and 
is listed in the Maps tree. You can also add files to the Files tree and load specific 
layers in different ways.

To add a file to the Files tree:
1. In the Focus window, click the Files tree.

The files and layers available in your current project are listed.

2. In the Files tree, right-click within the white area.
A shortcut menu appears.

3. From the shortcut menu, select Add.
4. From the GEO Data folder, select toronto_dem.pix.
5. Click Open.

The toronto_dem.pix files is listed in the Files tree, but no data is displayed.

Now that this file is part of the project and is listed in the Files tree, you will load 
the DEM layer as a pseudo-color layer.

To load a pseudo-color image from the Files tree:
1. Expand the list of rasters in the toronto_dem.pix file.
2. Right-click the DEM channel.
3. From the shortcut menu, select View As Pseudocolor.

The DEM is displayed in Focus as a pseudo-color layer.
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Figure 1.7           
Pseudo-color image 
displayed in Focus

Tip
You can also load grayscale layers and RGB layers from the Files Tree. For an 
RGB layer, use your CTRL key to select three channels. The order you select 
your channels is the order they will be displayed as RGB.

Layer Visibility When you open a file, a layer of data is listed in the Maps tree. You can hide a layer 
in the Maps tree by clearing the check box to the left of the layer.

To edit the layer visibility:
• In the Maps tree, clear the check box beside the Panchromatic layer.

The Panchromatic band is no longer visible.

Layer Priority You can change the priority of a layer by dragging it up or down the Maps tree. 
Layer priority can cause one layer to mask another in the view area. If you cannot 
see a layer that should be visible, check the layer priority.

To change layer priority: 
1. In the Maps tree, click the DEM Pseudocolor layer.
2. Drag the layer down the Maps tree below the Grayscale layer.

A black line shows the layer position. The Grayscale layer is now viewed on 
top of the DEM image.
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Figure 1.8             
Dragging a layer in the 
Maps tree

Map View Mode versus Area View Mode

There are two modes in which you can work in Focus; Map View Mode and Area 
View Mode. Map View Mode allows you to see the Map or blank sheet of paper 
upon which your project is placed. You may also set the dimensions of the page 
and organize elements of your project in Map View Mode. Area View Mode hides 
the Map (blank sheet of paper) and allows you to work within one Area. In a typical 
Focus project, you would first use Map View Mode to specify the size of your Map. 
Area View Mode would then be used for all processing of data. At the end of your 
project when map output is required, you would return to Map View Mode to 
organize the elements of your map project for presentation purposes.

To view an image in Map View Mode:
1. On the Focus toolbar, click Map View.

Figure 1.9                    
Map View Mode on the 
Toolbar

The map upon which your three layers are placed becomes visible.

2. In the Maps tree, right-click the Map level.
3. From the shortcut menu, select Properties.

The Map Properties dialog box opens.

4. From the Map Properties dialog box, select the Page Setup tab.
5. Change the orientation of the page to Landscape.
6. Click OK.

The page orientation is updated in the Focus view area.



Lesson 1.1  Viewing and Managing Layers

PCI Geomatics 17

Now that the Map orientation has been determined, you can switch back to Area 
View mode for further processing.

To switch back to Area View Mode:
• From the View menu, select Area View Mode.

The map disappears and you can continue working with the layers in your 
Maps tree.

Changing Layer Properties

Using the Layer 
Manager

The Layer Manager manages all layer properties in a convenient table format. The 
table shows the current properties of each layer in the map, and the hierarchical 
structure including maps, areas, and layers. This tool is very useful for managing a 
large combination of data layers, both raster and vector, such as when making a 
map. By using the Layer Manager you can control the layer hierarchy to ensure that 
one layer does not cover another.

To open the Layer Manager:
• From the Layer menu, select Layer Manager.

The Layer Manager dialog box opens.

Figure 1.10                     
The Layer Manager

Note
Each parameter set using the Layer Manager is also accessible by right-
clicking the layer in the Maps tree and selecting Properties. 

To change Layer Opacity in the Layer Manager:
1. For the Panchromatic layer, select the Opacity Active check box.

A check mark appears and the Opacity % property is active.

2. In the Opacity % text box, enter an opacity value of 50%.
3. Click Apply.

The pseudocolor layer can be seen beneath the panchromatic layer.

4. Clear the Opacity Active check box.
5. Click OK.

The Layer Manager closes and Opacity is turned off.
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Layer 
Properties

Focus provides Properties dialog boxes for all layer types. Properties dialog boxes 
have tabs with layer-specific settings that you can adjust for the data type you are 
working with. Properties dialog boxes always show information specific to the 
layer and the layer type you have chosen. Information and inputs vary depending 
on the type of layer you have chosen.

Before you start this next example, drag the RGB layer to the top of the Maps tree 
and drag the panchromatic layer to the bottom of the Maps tree. Alternatively, you 
can turn off the visibility of the panchromatic layer.

To view Layer Properties:
• In the Maps tree, right-click the toronto_l7 RGB Layer and select 

Properties.

Figure 1.11                 
Layer Properties selected 
from the Maps Tree

The RGB Layer Properties window opens.
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Figure 1.12                 
Layer Properties

The Layer Properties dialog box provides layer-specific settings to adjust the 
properties for any layer. The General tab indicates the name of the layer, its 
priority, the resample method, and current enhancement for that layer. The Source 
Images tab lists which layers are displayed as RGB, and which file the layers are 
from. The Source LUTs tab displays available look-up tables for each band. In the 
Display tab, you can alter transparency for each band and opacity for the layer. 
Finally, the Display within Zoom Scale tab allows you to specify a zoom scale for 
the layer.

In this example, you will change the transparency of the toronto_l7.pix RGB layer.

To set layer transparency:
1. In the Layer Properties window, click the Display tab.
2. Select the Transparency option.

The Transparency section becomes active.

3. In each of the Red, Green and Blue values text boxes, specify the values 
80:255 and click Apply.
Pixel values between 0 and 80 from each band remain displayed, while values 
greater than 80 are transparent and the pseudo-colored DEM can be seen.

4. To return to normal display, clear the Transparency option and click OK.

File Properties The File Properties dialog box contains important information about the selected 
file. It has tabs for displaying general information, such as file size, creation date 
and raster size, as well as history, metadata and projection information.

To view File Properties:
1. In the Focus window, select the Files tab.
2. Right-click the toronto_l7.pix file and select Properties.
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Figure 1.13                      
File Properties

The File Properties dialog box opens.

Figure 1.14                      
File Properties dialog box

In this lesson you:

• Opened different types of layers

• Used Map View Mode and Area View Mode

• Managed layer properties

• Viewed file properties
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Lesson 1.2 Using the Zoom and Pan Tools

In this lesson you will:

• Use the Overview and Zoom Windows

• Use the Zoom and Pan Tools

• Create Named Regions

When working with images in Focus, it is important to be able to navigate around 
the image effectively. The zoom and overview windows, panning, zooming, and 
creating named regions allow you to navigate quickly and effectively.

Using the Overview Window

The Overview Window displays a smaller version of the image in the Focus view 
area. It has a bounding outline that you can use to control the display of data in the 
view area. You can resize the bounding outline and zoom to certain locations in the 
image. By default the Overview Window is not active when you open Focus. You 
will begin by activating the Overview Window.

To display the Overview Window:
1. From the Tool menu, select Options.

The Options dialog box opens.

Figure 1.15          
Options dialog box

2. From the list on the left, select General interface.
3. In the Show section, select the Overview Window option.
4. Click OK.

The Options dialog box closes and an Overview window appears in the 
bottom left corner of the Focus window. A red bounding box outlines the area 
you are zoomed to.
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To zoom using the Overview window:
1. Inside the Overview window, move your mouse pointer over a corner of the 

red bounding box.
2. When your mouse pointer changes to a double headed arrow, drag the 

bounding box in or out from the corner.
The bounding outline resizes and the Toronto data in the view area zooms in 
or out relative to the area defined by the bounding outline.

When the bounding outline is smaller than the image in the Overview window, you 
can click inside it and pan through the image in the Focus view area. Dragging the 
bounding outline in the Overview window moves the image in the Focus view area 
without changing the zoom level.

Using the Zoom Window

The zoom window lets you see a linked copy of your image data in a separate 
viewer. You can zoom the images independently, using one image to locate 
features and the other to zoom them for a closer look.

To open and use the Zoom Window:
1. From the View menu, select Zoom Window.

The Zoom window opens.

Figure 1.16              
Zoom Window

2. In the upper-left corner of the zoom window, click the Lock Window 
Position button.

3. Click in the Focus view area.
The cursors in both windows are linked, but the image in the Zoom Window 
does not change.

4. To unlock the Zoom Window, click the Lock Window Position button again.
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Zoom Tools

There are several ways to zoom an image in the Focus view area. You can zoom in 
or out to a particular location even when you have multiple images opened. The 
following tools are located on the Focus Zoom Toolbar.

Figure 1.17                            
Zoom Toolbar

Zoom to 
Overview

The Zoom to Overview tool allows you to decrease the magnification so the whole 
image appears in the view area.

To use the Zoom to Overview tool:
• On the Focus toolbar, click the Zoom to Overview button.

Zoom 
Interactive

Zoom Interactive lets you drag a rectangle over the area you are interested in 
magnifying.

To use the Zoom Interactive tool:
1. On the Focus toolbar, click the Zoom Interactive button.
2. Use your mouse to define an area to magnify.

The image in the Focus view area zooms to the area you defined.

Zoom In/Zoom 
Out Tools

The Zoom In/Zoom Out tools allow you to incrementally increase or decrease the 
magnification based on your cursor location.

To use the Zoom In/Zoom Out tools: 
1. Click in the Focus view area.
2. On the Focus toolbar, click the Zoom In button.

The image is enlarged by a factor of 2.

3. To zoom out, click the Zoom Out button.

1:1 Image 
Resolution

1:1 Image Resolution adjusts the magnification so that one screen pixel displays 
one image pixel. This is the zoom level at which you can visualize your raster data 
without it being pixilated or decimated.

To view 1:1 image resolution: 
1. In the Focus view area, click an area near the lake.
2. On the Zoom toolbar, click the Zoom to 1:1 Image Resolution button.

The image changes to display at 1:1 resolution.
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Pan Tool When you have a very large image file open in Focus or when you have your image 
zoomed closer than the overview, you can move the image around in the Focus 
view area. There are two ways to pan images.

To pan an image:
1. On the Focus toolbar, click the Pan button.

Your mouse pointer changes to a hand pointer.

2. Click and drag the image in the direction you want to move.

Or:
1. In the Overview window, click inside the bounding outline.
2. Drag the bounding box toward your region of interest.

The image in the Focus view area moves to match the location of the 
bounding box in the Overview window.

Note
You can also scroll an image in Focus using the standard scroll bars along the 
horizontal and vertical edges of the Focus view area.

Creating Named Regions

You can create a custom view of your map or image with the Named Regions tool. 
Upper left and lower right corner coordinates are used to define new named 
regions.

Adding a New 
Named Region 

First, define the boundaries of your new region using the zoom tools on the Focus 
toolbar.

To add a Named Region:
1. Zoom to the Toronto Island along the lake.

The image zooms to show the selected region.

2. From the View menu, select Named Regions.
You can also click the Named Regions button on the Zoom toolbar.

The Named Regions dialog box opens.
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Figure 1.18            
Named Regions dialog 
box

3. In the lower-left of the Named Regions dialog box, click the + button.
A new Named Region is added to the Named Regions Maps tree which is 
labeled Named Region 1.

4. For the name of the region, type Toronto Island.

Figure 1.19           
Named Regions dialog 
box with Toronto Island 
region labeled

5. On your keyboard, press Enter.
6. Repeat steps 1 through 5 to create another named region for a different 

location.

Tip
Click the Advanced button to define your Named Region using exact 
coordinate information.

To display a Named Region in the Focus view area:
1. On the Zoom toolbar, click the Zoom to Overview button.

If you closed the Named Regions dialog box, reopen it by clicking the Named 
Regions button from the Focus toolbar so you can select the named region 
you want to display.

2. In the Named Regions dialog box, click the Toronto Island region.
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3. Click Apply.
The Toronto Island region is displayed in the view area.

Tip
You can also zoom to a Named Region by right-clicking in the Focus view area 
and selecting Named Region from the Zoom To submenu.

To remove a Named Region:
1. Select the Named Region you want to remove.
2. Click the - button.

The Named Region is removed from the Maps tree.

Note
To save your Named Regions, you must save your current project.

In this lesson you:

• Used the Overview and Zoom Windows

• Used the Zoom and Pan Tools

• Created Named Regions
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Lesson 1.3 Using Visualization Tools

In this lesson you will:

• Use the automatic Visualization Tools to examine multiple images

• Compare images with the Clone View

Focus 
Visualization 
Tools

Focus provides a set of active visualization tools that can automate the way you 
visualize your data. The visualization tools are ideal for work requiring change 
detection between images acquired at different times. You can also use the 
visualization tools to ensure accuracy in your map projects when you use imagery 
as a background layer to update vector or bitmap data.

The visualization tools let you view and compare multiple image layers 
simultaneously in a variety of ways. You can automatically browse a set of image 
layers or blend different images to see specific parts of one image through another. 
The visualization tools are versatile and can be used with any of the Focus 
enhancements or filters to make your work easier and more precise.

In this lesson, you will use the three images loaded in the previous lesson to 
experiment with the visualization tools.  First, you will give the SPOT image the 
highest layer priority and visualize two images with the Flicker, Swipe and Blend 
tools.  Then, you will make all three layers visible and visualize all three images.

To change layer priority:
• Drag and drop the toronto_spot.pix Grayscale layer to the top of the Maps 

tree.
The Toronto SPOT image has the highest layer priority.

You will now visualize the two layers with the highest layer priority using Flicker, 
Swipe and Blend.
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To open the Visualization Tools:
1. From the View, select Visualization Tools.

The Visualization Tools dialog box opens.

Figure 1.20             
Visualization Tools dialog 
box

2. Using the zoom tools, zoom to the extents of the Toronto SPOT image.
The extents of the DEM are much larger than the SPOT or the Landsat image. 
Zooming will allow much closer comparison between the two images.

Some visualization tools have different data requirements. For example, the 
Flicker, Blend, and Swipe tools require more than one image layer to be visible. 
The Loop tool requires a minimum of three layers to be open and the Cycle tool 
requires either an RGB or a hyperspectral file.

Flicker Tool The Flicker tool switches your view between the two images making it easier to see 
subtle differences between them. You can use the Flicker tool manually or you can 
set it up to work automatically at the speed you want.

Take some time now to experiment with the Flicker tool. You can change the frame 
rate of the flicker by clicking in the Speed box and typing a new frame rate.

When you have finished experimenting with the Flicker tool, click the Swipe tab.

Swipe Tool The Swipe tool swipes one image across another, one segment at a time, so that at 
any point during the process, you are looking at a specific proportion of the images. 
You can adjust the size of the swipe segment, change the swipe from horizontal to 
vertical, and set the frame rate for the swipe movement across the screen.

When you have finished experimenting with the Swipe tool, click the Blend tab.
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Blend Tool The Blend tool slowly merges two image layers together. The slow transition from 
one view to another helps you see changes between image layers. You can 
manually adjust the position of the blend to increase and decrease the blend 
percentage, or use the auto mode features to change the frame rate and the step size.

When you have finished experimenting with the Swipe tool, click the Loop tab.

Loop Tool The fourth visualization tool is the Loop tool. To make this tab available, you must 
have three or more layers open in the Focus work area.  It is a similar tool to Flicker 
but works with many layers.

Take some time now to work with the Visualization tools to see the adjustments 
and effects you can achieve on your own. Note the differences between the three 
images.

Band Cycling Band cycling is another visualization tool designed for hyperspectral data. It gives 
the user a quick way to cycle through different channel or wavelength ranges in a 
specified color component and to create new color composites.

When you have finished experimenting with the Band Cycling tool, close the 
Visualization tools dialog box.

Clone View Clone View opens a second window for the current project. Data displayed in the 
Clone View is listed in the Maps trees of the original Focus window.

Clone Views are independent of the original project window. Changes made to the 
project are not reflected in the cloned window. Once a Clone View is open, a new 
image can be opened in the project window with no effect on the cloned view.

To open the Clone View:
• From the View menu, select Clone View.

The Clone View window opens and a clone of the original Map, Area and 
Layers appear in the Maps tree.
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Figure 1.21              
Clone View

When you have an open Clone View window, you can use the Chained Window 
option to join the clone window with the original window. When the windows are 
chained, the cursors are linked.

To chain windows together:
1. On the Focus toolbar, click the Chained Window button.
2. In the Clone window, click the Chained Window button.
3. Click in the Focus view area.

The cursors are linked in both windows.

You can use the Clone View tool for several tasks. For example, if you want to 
compare classified images with reference images or if you want to analyze multi-
temporal imagery, you can use Clone View to open several independently 
enhanced versions of the same image to help discriminate certain features.

Now that the Clone View is open and the windows are linked, you will zoom to the 
same location in both windows and compare different band combinations.

To compare images using the Clone View:
1. In both the Focus window and the Clone window, zoom to the RGB layer.

You may need to change your layer priority so the RGB layer is displayed on 
top.
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2. In the Clone View window, change the combination of three bands being 
displayed as RGB using the RGB Mapper.

3. Apply an adaptive enhancement to the new color composite.

Changes are made to the RGB layer displayed in the clone window, but the layer 
does not change in the original image.

To remove the Clone View:
1. Close the Clone window.
2. In the Focus Maps tree, right-click Clone of Unnamed Map and select 

Remove.
The Clone View Map, Area and Layer are removed from the Maps Tree.

In this lesson you:

• Used the automatic Visualization Tools to examine multiple images

• Compared images with the Clone View
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Lesson 1.4 Using the Measure Tool

In this lesson you will:

• Measure the size of a feature

Measuring 
Distances and 
Area

You can measure features in the Focus view area using the Measure tool. Select 
either the Line, Polygon, Rectangle or Ellipse tool to compute measurements of 
distance and area.

To use the Measure tool:
1. On the toolbar, click the Measure arrow and select Polygon.

The Polygon measurement tool is now active.

Figure 1.22        
Measure Tool in Focus

2. Using the zoom tools, zoom to Lester B. Pearson International Airport.
The image zooms to show the selected region.
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Figure 1.23          
Pearson International 
Airport

3. Roughly outline the airport area using the Polygon measurement tool.
Measurements for the area are displayed on the status bar.

Experiment with the other measurement tools available in Focus.

Note
You are able to specify the units of measure by selecting the arrow beside the 
measurement tool and choosing the appropriate units from the Linear Units, 
Area Units, or Angle Units menus.

In this lesson you:

• Measured the size of a feature
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Module

 2 
Working with Image Data

Module 2 has Four Lessons:

Lesson 2.1     Exporting and Importing Data

Lesson 2.2     Projection Metadata and Assigning Projection

Lesson 2.3     Reprojecting Data

Lesson 2.4     Clipping / Subsetting

Working with 
Data

Geomatica Focus provides many easy to use tools to preprocess your data. 
Importing and exporting tools are useful when working with other geospatial 
packages. More than 100 geospatial data formats are supported by 
Geomatica’s GeoGateway technology.

Projections and coordinate systems are fundamental to geospatial files. Any 
GeoGateway supported file that can store projection information can be 
reprojected in Geomatica.

The Clipping / Subsetting tool can be used to create a small area of interest 
from a larger dataset. A small representative area from a larger file can be used 
to reduce computing time while determining the workflow and parameters to 
use when processing your data.

In Module 2, many features that are useful in preprocessing your data including 
importing and exporting data, assigning projection and reprojecting data, and 
clipping and subsetting geospatial data, are discussed.
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Lesson 2.1 Exporting and Importing Data

In this lesson you will:

• Export data from PCIDSK format

• Import data to PCIDSK format

Translating 
File Formats

Geomatica’s Generic Database (GDB) technology provides seamless and direct 
geospatial data transfer capabilities, which means that you can import, export, or 
read directly over 100 raster and vector formats.

The Translate utility can translate from one GeoGateway supported file format to 
another or create a new PCIDSK file from a GeoGateway format using only the 
layers you specify.

You will begin this lesson by translating the toronto_l7.pix file which should still 
be displayed in the Focus view area.

To translate a PCIDSK file as a GeoTIFF file:
1. In the Maps tree, select the RGB layer from the toronto_l7.pix file.

The file is active in the Maps tree.

2. From the File menu, click Utility and then click Translate.
The Translate (Export) File dialog box opens.

Figure 2.1                      
Translate (Export) dialog 
box

By default, the Source file is the file that is currently active in the Maps tree. To 
select a different file, click the Browse button next to Source File.

3. In the Translate (Export) File dialog box, click Browse next to Destination 
file.
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4. In the File Selector dialog box, type toronto_l7_geo.tif in the File name box, 
and click Save.

5. For the Output format, select TIF: TIFF 6.0.

Note
By default, Tiff files are exported in GeoTIFF format if georeferencing exists.

6. Under Source Layers, click Select All.
7. Click Add.

All of the source layers will be included in the output file.

Figure 2.2      
Completed Translate 
dialog box

8. Click Translate.
The file is exported in Geotiff format.
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Import Data to 
PCIDSK

The Import utility lets you work with any GeoGateway supported format in Focus 
by converting it to a PCIDSK file. When the format is not supported by 
GeoGateway you must define the raw data with the Raw File Definition tools.

Your files should be converted to PCIDSK format when:

• The original format does not support auxiliary information such as 
georeferencing, look-up tables, pseudo-color tables, and vectors.

• The original format cannot be updated

• In order to use certain programs in the Algorithm Librarian, Modeler or 
EASI.

To demonstrate the use of the import tool, you will create a new project and load a 
DEM file from California that is stored in TiffWorld format.

To start a new project:
1. From the File menu, select New Project.

A window opens asking if you would like to save project changes.

2. Click No.
A new project opens.

To import a file to PCIDSK format:
1. From the GEO Data folder, open the file dem.tif.

This is a DEM of an area in California stored in TiffWorld format.

2. From the File menu, click Utility and then click Import to PCIDSK.
The PCIDSK Import dialog box opens. The dem.tif file is listed as the Source 
file as it is active in the Maps tree.

Figure 2.3                     
Import Dialog Box

Note
A TiffWorld file is an image format consisting of two related files; the .tif file 
which holds the image, and the .tfw file which holds the georeferencing for the 
image.
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3. Next to Destination file, click Browse and locate the GEO Data folder.
The File To Save dialog box opens.

4. Type dem.pix beside File name and click Save.
5. Accept the default selection of Band interleaved for Format options.

Note
The Format options can improve the performance of a file and save disk space 
when you are using large files. There are several interleaving and compression 
methods available for raster data including Band Interleaved, Pixel Interleaved, 
File Interleaved, Tiled, Tiled (JPEG Compressed), and Tiled (Run Length 
Compressed).

6. Accept the default selection of Nearest neighbor downsampling for Overview 
options.

Note
Although Overviews can increase the required disk space by as much as 15 
percent, they allow images to open much faster than full resolution images.

7. Click Import.
A Progress Monitor appears and the DEM is imported to a PCIDSK file.

In this lesson you:

• Exported data from PCIDSK format

• Imported data to PCIDSK format
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Lesson 2.2 Assigning Projection

In this lesson you will:

• View projection information

• Assign projection to an imported file

• Save the assigned projection to the file

Projections A projection represents the earth's irregular three-dimensional surface as a flat 
surface. A map projection is used to transform the locations of features on the 
earth's surface to locations on a two-dimensional plane. A variety of map 
projections exist, usually based on one of the three basic types: azimuthal, conical, 
and cylindrical. For example, the Transverse Mercator Projection is a variation of 
the cylindrical projection.

A datum is a mathematical surface used to make geographic computations. An 
ellipsoid approximates the size and shape of all or part of the earth. The datum 
includes parameters to define the size and shape of the ellipsoid used, and its 
position relative to the center of the earth. Geographic coordinate systems use 
different datums to calculate positions on the earth.

If you compare the same point using two different datums or projections, the 
coordinates of the point will be different. Referencing a project’s coordinates to the 
wrong datum or using the wrong projection may result in features being offset by 
significant distances.

Different projections and datums introduce different distortions or warping into the 
image. You should choose the projection and datum that will give you the results 
that you expect for your project.

Data can sometimes be delivered with no projection system defined despite the 
data using a coordinate system other than pixel (i.e. Meter). Additionally, some file 
formats are unable to hold projection information (e.g., Tiff World, DXF). The data 
must be imported into a file format in which it is possible to update and save the 
projection information before the projection can be defined. A projection can only 
be assigned if the data and the coordinates it uses are actually in the projection to 
be assigned.

Note
Assigning projection and reprojecting are not the same.
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For this lesson, you will open the DEM file you imported to PCIDSK format and 
assign the appropriate projection information.

To view projection information:
1. From the GEO Data folder, open dem.pix.

The DEM is displayed and a grayscale layer is added to the Maps tree.

2. In the Focus window, click the Files tree.
The available files are listed.

3. Right-click the dem.pix file and select Properties.

Figure 2.4                      
File Properties

The File Properties dialog box opens.

4. Click the Projection tab.
The projection information for this file is displayed.
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Figure 2.5        
Projection tab

You will now assign the UTM coordinate system to this file.

To assign projection to an imported file:
1. From the coordinate system menu, select UTM.

UTM becomes the selected projection and the Earth Model dialog box opens.

2. In the Earth Model dialog box, click the Ellipsoids tab.
3. Select E000 - Clarke 1866 and click Accept.

The UTM Zones dialog box open.

4. Select Zone 11 and click Accept.
The UTM Rows dialog box opens.

5. Select Row S and click Accept.

Figure 2.6                
Assigned Projection 
Information

6. In the File Properties dialog box, click OK.
The projection information has been assigned and the File Properties dialog 
box closes.
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In order to save this projection information, you must now save the file.

To save the file:
• In the Files tree, right-click the dem.pix file and click Save.

The file and newly assigned projection is saved.

Note
When working with vector layers, you must assign projection not only to the file, 
but also the individual vector layer(s) as well.

In this lesson you:

• Viewed projection information

• Assigned projection to an imported file

• Saved the assigned projection to the file
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Lesson 2.3 Reprojecting Data

In this lesson you will:

• Set up for reprojection

• Set reprojection bounds

• Reproject an image

Reprojection When you add new data to the Focus view area, it is reprojected automatically 
based on the first layer sent to the view area. For example, if you have a layer open 
in Focus that is in Lat/Long, and then load another layer that is in UTM, the UTM 
layer will be reprojected on-the-fly to Lat/Long. If a reprojection is not possible, the 
new layer will be placed in another area.

When you open large, secondary files of different projections, they are 
automatically reprojected, which can make your work slower. In such cases it is 
best to reproject the data manually and save it as a new file.

You can reproject both raster and vector data. Your source files must be a 
GeoGateway supported format and they must use a valid projection. Destination 
files are created in PCIDSK format automatically. Reprojections can be exported 
as any GeoGateway compatible format.

You will now open the file to be reprojected and open the Reprojection tool.

To set up for reprojection:
1. From the GEO Data folder, open irvine.pix and select it in the Maps tree.

This is the file to be reprojected.

2. From the Tools menu, select Reprojection.
The Reproject dialog box opens. Because the Irvine file is the active layer in 
the Maps tree, it is listed as the Source file and the Reprojection Bounds 
information is updated based on the projection of this file.

3. Click Browse next to Destination file and locate the GEO Data folder.
4. Type irvine_spcs.pix beside File name and click Save.

You have now specified the file to be reprojected and the file into which the 
reprojected data will be saved. Next, you will set the Reprojection Bounds.
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Setting 
Reprojection 
Bounds

There are three methods for determining the bounds of the data that is to undergo 
reprojection.

Pixels/lines and bounds: Varies the pixel size to create a file with the pixel, 
lines, and bounds values that you select.

Pixels/lines and resolution: Varies the bounds based on the resolution of the 
source file.

Bounds and resolution: Inputs the file size in pixels and lines, and changes the 
pixel size.

Reprojection bounds are displayed below the Bounds caption. In the menu beside 
the bounds caption, you can choose from either Geocoded or Geographic.

Geocoded: Displays the upper-left and lower-right bounds in Northings and 
Eastings.

Geographic: Displays the upper-left and lower-right bounds in Latitude and 
Longitude.

Selecting a 
Coordinate 
System

There are several coordinate systems to choose from including Universal 
Transverse Mercator (UTM), Longitude and Latitude (Long/Lat) and other generic 
and user-defined projections. In this example, you will reproject irvine.pix from 
UTM to the State Plane Coordinate System (SPCS).

To set the reprojection bounds:
1. From the coordinate system menu, select SPCS.

The State Plane Zones dialog box opens.

2. Select California Zone 6 (NAD27) and click Accept.
The State Plane Zone and Earth Model, SPAF 406  D-01, are now specified in 
the text box to the right of the Earth Model button.

3. On the right of the panel, click the Maximum Bounds button.
This will reset the boundary of the file to fit the full extent of the original data 
and adjust the pixel size to fit the file.

Now that you have selected your source and destination files and have specified the 
reprojection bounds, you need to select the layers of data you want reprojected.
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Selecting 
Database 
Layers for 
Reprojection

After specifying your reprojection, you can select the layers to use for your 
destination file. In the Source Layers section, you can list layers of a similar type 
that you wish to work with. For example, to show all available files, select All from 
the View menu. The list will show all files in the source list.

To reproject an image:
1. In the View list, select Imagery.

The list changes to show only the raster layers in your source list.

2. While holding your Shift key, select the first five layers of imagery.
3. In the middle of the panel, click Add.

The selected layers are transferred to the list of Destination Layers. You can 
reposition an item selected in the Destination Layers list by clicking the up or 
down arrow above the list box.

4. To remove a layer from the list, select the layer and click Remove.
5. Click Reproject.

A Progress Monitor opens showing the progress of the reprojection. When the 
reprojection process is finished, the Progress Monitor closes.

The reprojected file is not opened in the view area nor is it listed in your Files tree. 
You need to either open the file in a new Area or add it to your project by right-
clicking in the Files tree and selecting Add.

In this lesson you:

• Set up for reprojection

• Set reprojection bounds

• Reprojected an image



Lesson 2.4  Clipping/Subsetting

PCI Geomatics 47

Lesson 2.4 Clipping/Subsetting

In this lesson you will:

• Create a subset using user-entered coordinates

• Create a clipped file based on a vector

Creating 
Subset Files

Clipping and subsetting data are effective methods working with large data sets. In 
research and testing situations, you may want to create subsets of a large 
database. By working with small representative areas, you can reduce processing 
times or you can use your file subsets to test an image process. When you obtain 
a promising result on a subset, you can repeat the process on your larger, more 
complex scene.

Make sure Focus is open on your system desktop. You will create your first subset 
image from the l7_ms.pix file located in the GEO Data folder.

To start a new project:
1. From the File menu, select New Project.

A window opens asking if you would like to save project changes.

2. Click No.
A new project opens.

To create your first subset:

1. From the File menu, click Open.

The File Selection window opens.

2. Locate the GEO Data folder and open l7_ms.pix.
A three-band color composite opens in the Focus view area and an RGB layer 
appears in the Maps tree.

3. From the Tools menu, select Clipping/Subsetting.
The Clipping/Subsetting dialog box opens.

Note
It is not necessary to open and load the file you want to subset before 
subsetting the image. You can directly open the Clipping/Subsetting dialog box 
and select the Input file.
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Figure 2.7                     
Clipping/Subsetting 
dialog box

In addition to defining the portion of your image to include in your subset, you will 
use the Clipping/Subsetting panel to designate the input file and to select an output 
file for your subset.

To select the input and output files:
1. From the list of Available Layers, select the six original TM bands.

A check mark indicates the layers that will be clipped.

2. In the Output section, click Browse and locate the GEO Data folder.
3. For the File name, type l7_ms_sub.pix and click Save.

By default, the new file will be located in the user folder if a path is not 
specified.

Your new subimage has now been assigned a destination folder and file name. 
Next, you will define the size of the l7_ms_sub.pix file.

There are six methods for defining a clip region: User-entered Coordinates, Select 
a File, Select a Clip Layer, Select a Named Region, Select a Script Subset File, and 
Use Current View. For your first subimage, you will use User-entered Coordinates 
to define the area for your subset.
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To define the Clip Region:
1. For the Definition Method, select User-entered Coordinates.
2. For the Coordinate Type, select Raster extents.
3. For the Upper Left coordinate, enter 200P and 500L.
4. For the Lower Right coordinate, enter 1224P and 1524L.

As you enter the dimensions of your subset, Focus constructs a bounding box 
in the preview window showing the location and size of the subset image.

Figure 2.8                     
Clip Region for l7_ms.pix 

5. Click Clip.
A Progress Monitor opens indicating Focus is creating a subset of l7_ms.pix 
according to the coordinates you entered.

Clipping From 
a Vector

It is also possible to clip data using an irregular polygon to define the outline of the 
clip area. This is useful if you need to clip layers based on a specific area such as 
the outline of a lake or the boundary of a park. First, you must select the irregular 
polygon in the Focus viewer.

To select the irregular vector:
1. In the Focus window, click the Files tree.
2. In the l7_ms.pix file, expand the list of vector layers.
3. Right-click the Poly: Clip Layer and select View.

The Clip Layer polygon opens in the viewer.
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4. On the Editing toolbar, click the Selection Tools button.
5. Click near the polygon displayed in the view area.

The polygon is selected and is highlighted in green.

Now that you have selected the polygon for clipping, you will set up the output file.

To select the output file:
1. In the Output section of the Clipping/Subsetting dialog box, click Browse and 

locate the GEO Data folder.
2. For the File name, type l7_ms_clip.pix and click Save.

By default, this file will be located in the user folder if a path is not specified.

3. Select the Set as No Data Value option.
This will assign pixels outside the shape boundary a metadata value of No 
Data. Pixels outside the shape boundary will not be displayed when loaded in 
the view area.

Your second subimage has now been assigned a destination folder and file name. 
Next, you will use Select a Clip Layer to define the area for your l7_ms_clip.pix 
subset.

To define the Clip Region:
1. For the Definition Method, choose Select a Clip Layer.
2. In the File list box, select l7_ms.pix.
3. From the Layer list box, select the Clip Region polygon layer.
4. Select the Clip using selected shapes only option.
5. For the Bounds options, select Shape(s) Boundary.

This will use the actual area covered by the vector as the clip region.

6. Click Clip.
A Progress Monitor opens indicating Focus is creating a subset of l7_pan.pix 
according to the irregular vector you selected.

Open the l7_ms_clip.pix file in Focus and edit the Display settings in the Layer 
Properties dialog box or use the Visualization Tools to verify the results.
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Figure 2.9               
Clipping based on a 
vector

In this lesson you:

• Created a subset using user-entered coordinates

• Created a clipped file based on a vector
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Module

 3 
Image Processing with 
Focus

Module 3 has Four Lessons:

Lesson 3.1     Enhancing Image Data

Lesson 3.2     Editing a Look-up Table

Lesson 3.3     Working with Spatial Filters

Lesson 3.4     Introduction to EASI Modeling

Image Data Geomatica Focus provides many tools for processing raster image data. 
Enhancements are used to display images so that objects or features in your 
imagery are easier to interpret. In Focus, images can be displayed with 
standard enhancements or with customized enhancements created by editing 
look-up tables. This will be outlined in the first two lessons.

In this module you will also become familiar with applying spatial filters, both 
low-pass and high-pass, to enhance areas of low or high spatial frequency. 
Finally, you will be introduced to EASI Modeling.
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Lesson 3.1 Enhancing Image Data

In this lesson you will:

• Open an image file and choose a default enhancement

• Apply different enhancements

• Adjust toolbar enhancements

• Change the image contrast and brightness

Enhancing 
Images with 
Focus

Original image files are often difficult to understand visually when you open them 
in an image viewer. Enhancements improve the contrast in an image and make 
visual interpretation easier. When you open an image file in Focus, it is 
automatically enhanced in the view area. You can choose the type of enhancement 
that Focus applies to images when they are opened.

There are three methods for enhancing images with Focus. For quick adjustments 
to your image data, you can use the Raster toolbar command buttons or the 
shortcut menu in the Focus Maps tree. For more detailed custom enhancements 
you can use the LUT Editor. The image enhancement is only applied through your 
system memory and must be saved if you want to use a particular LUT again or if 
you want to export the enhanced image.

The Raster toolbar includes contrast and brightness controls along with the 
following list of enhancements:

None: Removes all enhancements and displays the original unenhanced image.

Linear: Improves the overall contrast of an image by stretching the minimum and 
maximum values in the image uniformly over the entire available dynamic range. 
This enhancement is best applied to images that have a normal distribution of 
digital number (DN) values.

Root: Applies a square root enhancement (also known as a logarithmic stretch), 
which compresses higher DN values in an image and disproportionately expands 
the darker values. Original darker values in the image are given more contrast than 
the original bright (high-DN) values.

Adaptive: Applies an optimal enhancement curve, which is an adaptive 
derivative of an image histogram.

Equalization: Applies a histogram equalization enhancement.

Infrequency: Applies an infrequency enhancement, which maps gray levels 
based on frequency of occurrence.
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In this lesson, you will compare the standard set of enhancements available in 
Focus. You will begin by opening an image and removing the default enhancement 
to view the original unenhanced image. Then, you will select the default 
enhancement that best suits your needs.

To remove the default enhancement:
1. Click the New Project button on the toolbar.

2. From the File menu, click Open.
The File Selection window opens.

3. Locate the GEO Data folder and open radarsat.pix.
A grayscale Synthetic Aperture Radar (SAR) image of Irvine, California 
opens in the Focus view area. An Adaptive enhancement is applied by default.

Figure 3.1                               
radarsat.pix with default 
enhancement

4. In the Focus toolbar, click the Enhancements arrow and select None.
The image is displayed without an enhancement.

Choosing a Default Enhancement

You can change the default enhancement to any of the six enhancements available 
in Focus. Your new enhancement will then be applied to any image file you open 
in Focus.

To change a default enhancement:
1. From the Tools menu, click Options.

The Options dialog box opens.
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Figure 3.2                
Focus Options dialog box

2. In the Options dialog box, select Layers.
3. In the Rasters section, click the Default visual enhancement list box and 

select the Root enhancement.
4. Click OK.

Now when you open an image file in Focus the Root enhancement will be 
applied by default.

Applying Image Enhancements

Now that you have changed the default enhancement, you can try out the standard 
enhancements available in Focus. 

To apply the linear enhancement:
• On the Raster toolbar, click the Enhancements arrow and select Linear.

The display of the image changes, showing more contrast and detail.

With the linear enhancement applied, you can see more detail in the image. In the 
lower left, you can see a coastline and in the upper right, a mountain range.

Note
To see the entire RADARSAT image in the viewer, click the Zoom to Overview 
button on the Focus toolbar.

Next, apply the Root enhancement from the Raster toolbar so you can see even 
more detail in the image.
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Figure 3.3           
radarsat.pix with root 
enhancement

With the root enhancement applied, a T-shaped object is revealed near the left 
center of the image. Next, you will use the zoom tools to improve the display of 
this feature.

To zoom the image feature:
1. Click on or near the T-shaped object in the Focus view area.
2. On the Zoom toolbar, click Zoom 1:1 Image Resolution.

The image zooms to 1:1 resolution.

3. Click the Root enhancement again.

This time, Focus uses the statistics from the zoomed portion of the image to 
calculate the root enhancement. There is a slight change in the display of the image.

Note
When an image is zoomed, Focus uses the zoomed image statistics to 
calculate the enhancement. When an overview of the image is displayed, 
Focus uses all of the image statistics to calculate the enhancement.

With the image zoomed and the root enhancement reapplied, the T-shaped object 
can be identified as airport runways.
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Figure 3.4           
radarsat.pix with root 
enhancement at 1:1 
resolution

You can see how the root and linear enhancements make your imagery clearer and 
easier to interpret. Now try using the other enhancements in the list to give different 
views of the radarsat.pix image.

Adjusting Toolbar Enhancements

You can control how Focus computes each of the standard enhancements before 
they are applied to an image by adjusting the Tail Trim options from the Raster 
toolbar. By default, the Tail Trim option is selected. The pixel values for the image 
are averaged out over the dynamic range but the first 2% and the last 2% of values 
are omitted from the enhancement computation. You can also adjust the amount of 
tail trim from the enhancements list from 1% to 5%.

To adjust the amount of Tail Trim:
1. On the Raster toolbar, click the Enhancements arrow and select Set Trim%.
2. From the Set Trim% submenu, click 5.
3. Reapply your current enhancement by clicking the Enhancement button.

The visualization of the image changes to reflect the percentage of tail trim.

Note
To see the effects of adjusting the enhancement, it must be reapplied by 
clicking the Enhancements button on the Focus toolbar.

The enhancement now omits the first 5% and the last 5% of the pixel values when 
the enhancement is calculated. Next, you will compare an enhancement with and 
without the Tail Trim option.
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To remove the Tail Trim option:
1. On the Raster toolbar, click the Enhancements arrow and select Tail Trim.

The Tail Trim option is no longer selected.

2. Reapply your current enhancement by clicking the Enhancement button.
The display of the image changes dramatically.

You can also apply image enhancements with the shortcut menu in the Maps tree. 
The same image enhancement commands in the Raster toolbar are found in the 
shortcut menu.

To enhance an image from the shortcut menu:
1. In the Maps tree, right-click the radarsat.pix layer and select Enhance.
2. In the Enhance submenu, click any of the enhancements to apply them to your 

image.

Next, you will use the Contrast and Brightness tools to change the display of the 
image.

Adjusting Image Contrast and Brightness

Interpreting image data is often made easier by simply adjusting the image contrast 
and brightness. You can increase or decrease the image Contrast and Brightness 
with the Raster toolbar controls.

To increase the image contrast:
• On the Raster toolbar, click the Contrasts button.

To decrease the image contrast:
1. On the Raster toolbar, click the Contrasts arrow and select Decrease.
2. Click the Contrasts button again.

You can see a change in your image contrast each time you click the Contrasts 
button.

You can also choose Reset to return to the original the brightness level.

To increase the image brightness:
• On the Raster toolbar, click the Brightness button.

To decrease the image brightness:
1. On the Raster toolbar, click the Brightness arrow and select Decrease.

2. Click the Brightness button again.
You can see a change in your image brightness each time you click the 
Brightness button.
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Note
Each click changes the image contrast or brightness by approximately 10%.

In this lesson you:

• Opened an image file and choose a default enhancement

• Applied different enhancements

• Adjusted toolbar enhancements

• Changed the image contrast and brightness
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Lesson 3.2 Editing a Look-Up Table

In this lesson you will:

• Open the LUT Editor

• Use the graph editing tools

• Trace-edit a histogram to create a custom enhancement

• Compare different custom enhancements

Focus provides an LUT editor that allows you to create custom enhancements for 
imagery. You can use the graph editing tools in the LUT Editor to trace or edit a 
histogram and create a custom enhancement. You can also use the Toggle button 
to switch between custom enhancements.

The LUT Editor gives you greater control over the enhancement process by 
allowing you to directly edit an image histogram, compare the same image using 
different enhancements, and change the LUT to any values within a range.

To begin this lesson, make sure radarsat.pix is open in the Focus view area and that 
the image is zoomed to the image overview.

To open the LUT Editor:
1. In the Maps tree, right-click the radarsat.pix layer and click Enhance and 

then click Edit LUTs.
The Histogram Display dialog box opens.

Figure 3.5           
Histogram Display dialog 
box

2. In the Histogram Display dialog box, click the histogram.
The LUT Editor dialog box opens.
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Figure 3.6                        
LUT Editor showing the 
radarsat.pix image with a 
root enhancement

The LUT Editor shows two histograms: a gray histogram for the original image and 
a red histogram for the enhanced image. The black line is a representation of the 
current LUT.

Editing the LUT

Enhancements are applied to values within the bounds defined by the x-axis and y-
axis markers. The vertical markers set the minimum and maximum output 
grayscale values. The horizontal markers set the range of input grayscale values for 
an enhancement.

Moving the markers along the x-axis and y-axis changes the minimum and 
maximum input and output values. The exact values are shown in the boxes in the 
LUT values area. For a 16-bit image, the x-axis graph shows the input values from 
zero to 65535. The y-axis shows the output values from zero to 255.

To edit using the LUT level markers:
1. Drag the right-hand marker along the x-axis of the graph.

Figure 3.7                       
Drag the LUT level 
marker
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2. Click an enhancements in the Functions section on the right.
The shape of the enhancement histogram changes to show the new LUT 
values and the display of the radarsat.pix image changes.

You can also move the entire histogram to the right or left of the x-axis boundaries 
to change the range.

To move the entire histogram:
• In the graph area, right-click and drag the entire graph to the left or to the 

right.

You can undo edits and compare different versions of a histogram for the same 
image data using the tools on the LUT Editor.

Using the LUT 
Editing Tools

To allow tail trimming, select the Tail Trim option. In the Tail Trimming list box, 
select the tail trim percent from 1 to 5. You can also enable the Exclude Min/Max 
option. Once you apply an enhancement, it can be edited and customized.

Some of the other graph editing tools include: Add Breakpoint, Move Breakpoint, 
and Delete Breakpoint. These options let you edit the LUT for a specific location 
on the original image histogram. To show the breakpoints on the curve, select 
Breakpoints from the View menu. The Thin Breakpoints option removes excess 
breakpoints along straight stretches that are associated with an LUT.

Next, you will customize an enhancement by trace-editing the LUT histogram.

Trace-Editing 
the LUT

You can use the LUT Editor to create custom enhancements by directly editing the 
red histogram in the LUT graph. You can trace the general contours of the 
histogram you want. Focus redraws the image in the view area to show the new 
histogram values you created.

To trace-edit the LUT histogram:
1. In the LUT Editor, click the Manual Mode button in the Graph editing tools 

section.
2. Create a custom enhancement by trace-editing the histogram.

The histogram changes to display the new values you have set and the image 
in the Focus view area is displayed according to the new histogram.

Comparing 
Custom 
Enhancements

When the LUT Editor is opened, Focus stores a copy of the histogram as a smaller 
version and displays it to the right of the LUT editor in the preview window. You 
can create different custom enhancements and switch between the preview window 
and the LUT Editor using the Copy and Toggle buttons on the LUT Editor.
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To compare custom enhancements:
1. In the LUT Editor, click the Manual Mode button in the Graph editing tools 

section.
2. Create a custom enhancement by trace-editing the histogram.
3. Click Copy.

A copy of this histogram appears in the preview window.

4. Create a new trace-edit enhancement or click one of the enhancements in the 
Functions section on the right.

5. Click Toggle.
The histogram in the LUT editor changes to the preview histogram and your 
new histogram is now in the preview window.

Examining LUT 
Values

You can also edit the LUT directly in a spreadsheet-style dialog box by selecting 
Edit Table from the Graph editing tools.

To open the Look-Up Table for the histogram: 
1. In the Graph editing tools section, click the Edit Table button.

The Lookup Table dialog box opens.

2. In the Lookup Table dialog box, select the View Lookup Values option.

Saving the LUT

Custom enhancements can be saved either as LUTs or as image layers. Saving the 
enhancement as an LUT uses less memory and lets you have various enhancements 
for the same layer. This can be useful in detecting different ground features, each 
requiring unique enhancements.

To save a custom LUT:
1. From the LUT Editor menu bar, click Save and then click Save LUT.
2. On the Save As dialog box, click Save.

The image layer will always be displayed with the LUT if it is saved as the default.

To save as the default LUT:
1. From the LUT Editor menu bar, click Save and then click Save LUT as 

Default.
2. Click Save on the Save As dialog box.

Permanently applying an enhancement to an image layer saves you time if the same 
enhancement will always be used and allows you to export an enhanced image 
without exporting the LUT.
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To permanently enhance an image layer:
1. From the LUT Editor menu bar, click Save and then click Save Image with 

LUT.
2. In the Save As dialog box, you have the option of saving the permanently 

enhanced channel to a new file, overwriting an existing channel in 
radarsat.pix, or saving it to a new channel within radarsat.pix.

In this lesson you:

• Opened the LUT Editor

• Used the graph editing tools

• Trace-edited a histogram to create a custom enhancement

• Compared different custom enhancements
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Lesson 3.3 Working with Spatial Filters

In this lesson you will:

• Reduce image graininess with a low-pass filter

• Preserve image details with a speckle filter

• Emphasize image borders and edges with a high-pass filter

The Image 
Filter Kernel

Spatial filters are used to enhance areas of low or high spatial frequency. Low-pass 
filters are used to produce smooth images and reduce noise or graininess. High-
pass filtering is used to highlight fine spatial detail such as edges. The Focus Filter 
dialog box provides the tools to apply both high-pass and low-pass filters.

The filter process uses a moving box, referred to as a kernel, that samples the 
image and applies the filter to the center pixel in the sample. Once the filter is 
applied to the first sample, the kernel moves one pixel to the right and reapplies the 
filter until the entire image has been sampled. The kernel dimensions, measured 
in pixels, must always be an odd number, for example, 3x3 or 11x15. The larger 
the kernel, the more obvious the effect of the filter will be. When the entire image 
has been sampled, Focus applies the changes to the image in the view area.

Applying a 
Low-Pass Filter

Low-pass filters allow low spatial frequency variations to pass through, while 
removing or suppressing the higher spatial frequencies. They produce images that 
appear smooth or blurred when compared to the original data.

You will begin this lesson by applying a low-pass filter to the radarsat.pix image.

To apply a low-pass filter:
1. Make sure the radarsat.pix file is open in the Focus view area.
2. In the Maps tree, right-click the radarsat.pix layer and select Filter.

The Filter dialog box opens.
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Figure 3.8                   
Filter dialog box

3. For the Filter Size, enter 9 by 9.
4. Click the Low Pass tab.
5. Select the Average filter option.
6. Click Apply to View.

The image appears much smoother. The filter is only applied to the image in 
the view area.

Note
Image filters are not cumulative. Each filter is applied to the original data stored 
in the image file.

Take some time now to experiment with other low-pass filters and kernel size 
settings to compare the effects on the image.

Tip
You can apply filters to all data in a layer or you can select a bitmap mask to 
restrict the filtering process to a particular area in the layer.
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Applying a 
Speckle Filter

Coherent signal scattering in SAR data often causes image speckle or salt and 
pepper effects. Speckle is inherent in most SAR images and can inhibit accurate 
image interpretation. Special low-pass filters called speckle filters or adaptive filters 
can preserve image details by not filtering pixels associated with linear features.

The low-pass filter you just applied has reduced the image speckle, but has 
degraded some of the finer detail in the image. Next, you will apply a speckle filter 
to preserve some of the linear features in the image.

To apply a Speckle Filter:
1. For the Filter Size, enter 7 by 7.
2. In the Filter dialog box, click the Low Pass tab.
3. Select the Gamma filter option.
4. In the Number of Looks box, type 4.

This represents the number of noise-variance calculations for the radar image 
you are using.

5. In the Image Format list, select Amplitude.
6. Click Apply to View.

The Gamma filter has suppressed the image speckle while preserving the 
linear features.

7. Click Close to close the Filter dialog box.

Note
You must enter correct image information for the SAR data you are working 
with. The number of looks and the image format information is available in the 
format definition included with your data.

Figure 3.9                         
The radarsat.pix image 
with Gamma filter
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Applying a 
High-Pass 
Filter

High-pass filters emphasize border pixels between contrasting areas and are often 
referred to as edge detectors. Like speckle filters, they highlight pixel contrasts 
associated with linear features and edge details.

Next, you will open a Landsat 7 panchromatic image and apply a a high-pass filter 
to accentuate edge detail.

To apply a High-Pass filter:
1. From the GEO Data folder, open l7_pan.pix.

A Landsat 7 Panchromatic image opens in the Focus view area.

2. In the Maps tree, right-click the l7_pan.pix layer and select Filter.
 The Filter dialog box opens.

3. For the Filter Size, enter 7 by 7.
4. Click the High Pass tab.

Figure 3.10                         
The Filter panel showing 
the High Pass controls

5. Select the Edge Sharpening filter option.
6. Click Apply to View.
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Saving a 
Filtered Image

Once you have visually applied a filter to an image in the view area, you may 
choose to save the filtered image to a file.

To save a filtered image:
1. In the Filter dialog box, click Apply to File.

The Save New Filtered Image dialog box opens.

Figure 3.11               
Save New Filtered Image 
dialog box

2. In the Save New Filtered Image dialog box, select l7_pan.pix from the File 
list.

3. From the Layer list, select New Layer and type Edge Filter.
4. Click OK.

The high-pass filtered image is saved to a new layer within the l7_pan.pix file.

Try selecting other filter options and compare the results.

In this lesson you:

• Reduced image graininess with a low-pass filter

• Reduce SAR image speckle with a speckle filter

• Emphasized image borders and edges with a high-pass filter
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Lesson 3.4 Introduction to EASI Modeling

In this lesson you will:

• Add a 32-bit real image channel

• Create and run a simple model to generate an NDVI image

• Save your model as an EAS file

EASI 
Modeling

EASI Modeling in Focus uses the EASI scripting language to write scripts and run 
them on selected files. EASI Modeling in Focus uses a single input file. The model 
is performed directly on the database file. It is recommended that you keep a copy 
of the original input file before running the model.

Simple 
Modeling

Modeling equations, in their simplest form, are arithmetic combinations of image 
layers. Image layers are indicated by a percent sign followed by the layer number. 
Table 1 lists the standard set of arithmetic operations available in modeling 
expressions.

Table 1: Standard arithmetic operations

The following mathematical intrinsic functions are also available:

sin(), cos(), tan(), asin(), acos(), atan(), ln(), 
log10(), exp(), exp10(), rad(), deg(), abs(), int(), 
random() and frac()

a + b Addition

a - b Subtraction

a * b Multiplication

a / b Division

a ^ b Exponentiation

( a ) Parentheses, also square brackets []

- a Unary negation
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Basic Modeling 
Logic

In addition to simple assignment equations, you can also construct simple logical 
operations in the EASI Modeling dialog box. These operations take the form of 
"IF" statements. Table 2 lists the possible comparison and logical functions.

Table 2: Possible comparison and logical functions

You can also use brackets to ensure operations take place in the expected order.

All the rules previously indicated for image layers also apply to bitmap layers, 
except that the variables are prefixed with two percent signs instead of one. A 
bitmap layer is binary and can have a value of either 1 (ON) or 0 (OFF).

Tip
You can combine a group of files, regardless of bounds, projection, data type, 
or resolution into a single output file with the Data Merge Wizard from the Tools 
menu. Data in the new merged file will be resampled to a common projection 
and resolution.

In this example you will calculate a Normalized Difference Vegetation Index 
(NDVI) using the red and near-infrared bands in the irvine.pix file. The results will 
be output to the empty 32-bit image channel.

Note
The image and bitmap layers must exist in the PCIDSK file prior to running the 
model.

a > b a greater than b

a < b a less than b

a = b a equals b

a <> b a not equal b

a <= b a less than or equal b

a >= b a greater than or equal b

a OR b a is true or b is true

a AND b a is true and b is true

!a a is not true
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Adding an 
Image Channel

You can add 8-bit, 16-bit signed, 16-bit unsigned, or 32-bit real image channels to 
a selected PCIDSK file. Bit depth (also called pixel depth) refers to the range of 
numeric values stored in image layer data. The range of numbers each pixel can 
store increases with bit depth.

Supported bit depths are:

• 8-bit: 0 to 255
• 16-bit signed; -32,767 to + 32,768
• 16-bit unsigned: 0 to 65,535
• 32-bit real: approximately +/-1.2E-38 to 3.4E+38

You will need to add an empty 32-bit real channel in which to store the results of 
the NDVI calculation that you are going to perform.

To add a new image channel:
1. From the GEO Data folder, open the irvine.pix file.
2. Click the Files tree.
3. Right-click irvine.pix and select New and then click Raster Layer.

The Add Image Channel dialog box opens.

Figure 3.12                     
Add Image Channel 
dialog box

4. In the Add Image Channel dialog box, enter a 1 in the 32 bit real box and 
click Add.
A new 32-bit image channel is added to the irvine.pix file.

5. Click Close.

Now that you have added the channel that will store the results of the NDVI, you 
will create the NDVI image using EASI Modeling.

To calculate the NDVI using EASI Modeling in Focus:
1. From the Tools menu, select EASI Modeling.

The EASI Modeling window opens.
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Figure 3.13                  
EASI Modeling dialog box

2. From the Input File list, select irvine.pix.
3. In the EASI Modeling dialog box, enter the following model:

%12=(%4-%3)/(%4+%3)

Figure 3.14                  
EASI Modeling dialog box 
with NDVI model

4. Click Run.

The model is executed and the results of the NDVI calculation are saved to channel 
12 in the irvine.pix file and displayed in the Focus view area.

Saving EASI 
Models

Now that you have created your first EASI model, you will save it as an EAS file.

To save your EASI model:
1. In the EASI Modeling dialog box, click Save.

The File Selector dialog box opens.

2. Locate the GEO Data folder and save the file as NDVI.EAS.
3. Click Save.

The EASI model is saved and can be loaded for use with another input file.

In this lesson you:

• Added a new 32-bit real image channel

• Created and ran a simple model to generate an NDVI image

• Saved your model as an EAS file
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Module

 4 
Image Processing with the 
Algorithm Librarian

Module 4 has Four Lessons:

Lesson 4.1     Principal Component Analysis

Lesson 4.2     Scaling Imagery

Lesson 4.3     Performing Image Fusion

Lesson 4.4     Pansharpening Imagery

Algorithm 
Librarian

The Algorithm Librarian dialog box lets you access algorithms in the Algorithm 
Library. Algorithms are organized by themes or categories into a directory tree. 
You can expand a category in the tree to reveal sub-folders and algorithms.

You can search through the categories within each folder using the Find utility 
or you can browse through the categories based on the directory topics found 
in each folder.

Note
Algorithms that have a lock icon to the left of the algorithm name are not 
available with your current Geomatica license.

Tip
You can create a collection of shortcuts to your favorite algorithms by 
dragging the algorithms from a PCI-predefined folder to a User Defined 
folder. You can also create a shortcut by right-clicking a PCI-predefined 
algorithm and clicking Add to User Defined.

Every algorithm in the Algorithm Library has a Module Control Panel (MCP) 
that you can open from the Algorithm Librarian dialog box. Algorithm MCPs 
provide the controls for using the algorithms in the Algorithm Library and are 
linked directly to any open data. If you have data loaded in Focus before using 
the Algorithm Library, the data in the current project is listed under the Files tab 
in the Input Ports section of the algorithm MCP. You can select the input layers 
you want to process under the Files tab in the MCP Input Ports section before 
you run the algorithm.
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Lesson 4.1 Principal Component Analysis

In this lesson you will:

• Set up and perform Principal Component Analysis

Principal 
Components 
Analysis

Principal component analysis is a linear transformation that rotates the axes of 
image space along lines of maximum variance. The rotation is based on the 
orthogonal eigenvectors of the covariance matrix generated from a sample of 
image data from the input channels. The output from this transformation is a new 
set of image channels, which are sometimes referred to as eigenchannels or 
principal components.

The first eigenchannel contains the most variance in the dataset. The second 
eigenchannel accounts for additional variance in the dataset, but is uncorrelated to 
the first. The third eigenchannel accounts for the remaining variance not accounted 
for by the first two eigenchannels and is uncorrelated with either of them. This 
process continues until all the variance in the dataset is accounted for.

Applications of PCA include aiding in visual interpretation, as a preprocessing step 
prior to automated classification, and as a way of reducing the dimensionality or 
redundancies of a dataset. PCA should be used on RAW image data only.

In this lesson you will run this algorithm twice; first, to calculate the PCA 
transformation and second, to apply the transformation. This method is useful in 
determining the eigenchannels that should be retained before processing the data.

You will begin by starting a new project in Focus.

To start a new project:
1. From the File menu, select New Project.

A window opens asking if you would like to save project changes.

2. Click No.
A new project opens.

To open the PCA algorithm:
1. From the GEO Data folder, open irvine.pix.
2. From the Tools menu, select Algorithm Librarian.

The Algorithm Librarian dialog box opens.
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Figure 4.1         
Algorithm Librarian

3. Expand the Image Processing folder.
A subcategory of folders appears.

4. In the Image Processing category, expand the Image Transformations 
folder.
A list of algorithms is displayed.

Figure 4.2                   
PCA Algorithm

5. Select the PCA algorithm and double-click or click Open.
The PCA Module Control Panel opens.
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Figure 4.3                   
PCA Module Control 
Panel

Module Control Panels (MCP) are used to select imagery, set parameters, and read 
algorithm log notes. The Input Ports section contains a list of the files in the Focus 
Maps and Files trees. As you scroll through this list you will see the contents of the 
Maps tree followed by the contents of the Files tree.

You will now configure the Input Ports and select the layers to be transformed by 
the PCA algorithm.

To select the Layers to be Transformed:
1. In the Input Ports section, expand the Layers to be Transformed input port.

The tree expands to show the Maps and Files trees.

2. Expand the Files tree.
The Files tree expands to show the files associated with your project.

3. Expand the irvine.pix file.
The list expands to show the available raster layers in the file.

4. Select the check boxes beside TM bands 1 to 5.
Check marks appear in each box and the Layers to be Transformed input node 
turns green.
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Next you will configure the Output Ports. In the Output Ports section, the Viewer-
Grayscale option is selected by default.

To configure the Output Ports:
• In the Output Ports section, make sure the Viewer-Grayscale option is 

selected.

By specifying the Viewer as the output option, the resulting channels of data are 
not saved to a file; they are stored in memory. This allows you to test algorithms 
with different parameters and only save the desired output.

Before you run the PCA algorithm to calculate and examine the eigenchannels, you 
will set the input parameters.

To set the Input Parameters and calculate PCA:
1. In the PCA Module Control Panel, click the Input Params 1 tab.

Parameters specific to this algorithm are listed.

2. For the Eigenchannels Layer Numbers, enter 1,2,3,4,5.
This will calculate the eigenvectors for all five input channels.

3. For the Output Raster Type, select 8U.
4. For the Report Type, select SHORT.
5. Click Run.

A Progress Monitor opens on your desktop. When the algorithm has finished 
executing, the eigenchannels are displayed in the Focus view area and the 
report is displayed in the Log tab of the MCP.
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Figure 4.4                   
PCA Report

By visually examining the Eigenchannel layers displayed in the view area and by 
examining the information in the report, you can see that most of the variance is 
contained within the first three eigenchannels. Now you will perform the actual 
transformation and output the first three eigenchannels to a new file.

To configure the Output Ports:
1. In the PCA MCP, click the Files tab.
2. In the Output Ports section, select both the Viewer-RGB option and the 

Untitled.pix option.
A check mark appears in each box.

3. Right-click the text box containing the path to the Untitled.pix file and select 
Browse.

4. Locate the GEO Data folder.
5. For the File name, type irvine_pca.pix and click Save.

The path and file name are updated in the PCA Module Control Panel.

Tip
If a path for the output file is not specified, the file is saved in the user folder.
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Before you apply the PCA transformation, you will set the input parameters.

To set the Input Parameters and apply PCA:
1. In the PCA Module Control Panel, click the Input Params 1 tab.
2. For the Eigenchannels Layer Numbers, enter 1,2,3.

Only the first three Eigenchannel layers will be retained for output.

3. For the Output Raster Type, select 8U.
4. For the Report Type, select LONG.
5. For the Report Mode, select PCA.RPT.
6. Click Run.

The eigenchannels are created and saved to the output file and the report is 
generated. Eigenchannels 1, 2 and 3 now contain 99% of the variance from the 
original 5 input layers. You can also see a “richer” dataset by displaying the three 
eigenchannels as an RGB layer.

Figure 4.5  
Eigenchannels 1, 2 and 3 
displayed as a color 
composite in the view 
area

In this lesson you:

• Set up and performed Principal Component Analysis
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Lesson 4.2 Scaling Imagery

In this lesson you will:

• Scale an image from 16-bit to 8-bit

Scaling 
Imagery

Remote sensing data is structured in 8-bit, 16-bit, and 32-bit formats. There are 
many instances where you may need to scale your data from a higher to a lower 
bit depth. For example, you can prepare data for visual display by scaling it from 
16-bit or 32-bit to 8-bit. You can also scale data to a lower bit depth before you 
export it to applications that do not support data bits greater than 8. Scaling will let 
you change 32-bit real data from a real number to a whole number. This will also 
reduce the file size of your imagery. However, there is a risk of losing information 
when you scale to reduce file size.

For 8-bit data, the digital numbers (DN) assigned to each pixel are between zero 
and 255. For 16-bit data, DNs can fall between zero and 65,535. Because our eyes 
are not sensitive to these subtle differences in grayscale or color, we cannot 
visually benefit from images composed of thousands of shade variations. 

SCALE can also be used to stretch or shift the dynamic range of an input image for 
visual enhancement. Available algorithms include scaling with tail trimming and 
enhancement (using linear, squared, logarithmic, square root, or general power 
functions), automatic normalized quantization, and equal-area quantization.

The SCALE algorithm available in the Algorithm Library gives you control when 
scaling an image by allowing you to specify your input minimum and maximum and 
your output minimum and maximum values. You can also specify the left and right 
tail trimming, the scaling function, and the bit depth for the output layer.

In this lesson, you will open a Radarsat image and scale it from 16-bit to 8-bit.

To open the SCALE algorithm:
1. Start a New Project.
2. From the GEO Data folder, open radarsat.pix.
3. From the Tools menu, select Algorithm Librarian.

The Algorithm Librarian dialog box opens.
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Figure 4.6         
Algorithm Librarian

4. Expand the Image Processing folder.
5. In the Image Processing category, expand the Image Transformations 

folder.
A list of algorithms is displayed.

6. Select the SCALE algorithm and double-click or click Open.
The SCALE Module Control Panel opens.

Figure 4.7              
SCALE Module Control 
Panel
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You will now configure the Input Ports.

To select the Unscaled Raster Layer(s):
1. In the Input Ports section of the Files tab, expand the Unscaled Raster 

Layer(s) input port.
2. In the Files, expand the radarsat.pix file.
3. Select the check box beside the Standard 2 Beam Mode layer.

A check mark appears in the box and the Unscaled Raster Layer(s) input node 
turns green.

Next you will configure the Output Ports. In the Output Ports section, the Viewer-
Grayscale option is selected by default. You will leave this Viewer option selected 
so the results will be automatically displayed.and also specify an output file to store 
the results.

To configure the Output Ports:
1. In the Output Ports section, make sure the Viewer-Grayscale option is 

selected.
2. Select the Untitled.pix option.

A check mark appears in the box.

3. Right-click the text box containing the path to the Untitled.pix file and select 
Browse.

4. Locate the GEO Data folder.
5. For the File name, type radarsat_scaled.pix and click Save.

The path and file name are updated in the SCALE Module Control Panel.

Tip
If a path for the output file is not specified, the file is saved in the user folder.

Before you run the SCALE algorithm, you will set the input parameters.

To set the Input Parameters and run SCALE:
1. In the SCALE Module Control Panel, click the Input Params 1 tab.

Parameters specific to this algorithm are listed.
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Figure 4.8               
SCALE Module Control 
Panel

2. For the Minimum Input Gray Level Value, type 0.
3. For the Maximum Input Gray Level Value, type 30000.

This is the range of values used from the input channel(s). The tail trimming 
option is grayed out when using these parameters.

4. For the Scaling Function, select LIN.
This function equally scales data values from the input range to the output 
range.

5. For the Output Type, select 8 bit Unsigned.
6. Click Run.

A Progress Monitor open on your desktop. When the algorithm has finished 
executing, there is a message in the Log tab indicating it scaled the input 
values across the full range of values for an 8-bit channel. The scaled image is 
also displayed in the view area.

In this lesson you:

• Scaled an image from 16-bit to 8-bit
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Lesson 4.3 Performing Image Fusion

In this lesson you will:

• Set up and perform image fusion using the FUSE algorithm

• Compare histograms

FUSE The FUSE algorithm performs image fusion of a Red-Green-Blue (RGB) color 
image with a black-and-white intensity image using the Intensity-Hue-Saturation 
(IHS) transformation. The result is an output RGB color image with the same 
resolution as the original black and white intensity image, but where the color (hue 
and saturation) is derived from the resampled input RGB image.

With the Intensity-Hue-Saturation transformation image fusion technique, red, 
green and blue image channels are converted to intensity, hue and saturation 
image channels. The intensity channel is then substituted with the high resolution 
panchromatic image and the dataset is then converted back to the original RGB 
color space.

If the input and output files are different, the input RGB colour image is resampled 
using the specified resampling method. Either the Hexcone or Cylinder IHS color 
model is used for image fusion.

Tip
Alternatively, you can use the IHS and RGB algorithms, which allow you to 
enhance the output from IHS individually and then use the enhanced output in 
RGB.

For this lesson, you will begin by starting a new project in Focus.

To start a new project:
1. From the File menu, select New Project.

A window opens asking if you would like to save project changes.

2. Click No.
A new project opens.

Before you set up and run the FUSE algorithm, you will open the files you are 
going to fuse.
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To open the datasets to be fused:
1. From the File menu, select Open.

A File Selection window open.

2. Locate and open the GEO Data folder.
3. Hold down the Ctrl key and select toronto_qb_ms.pix and 

toronto_qb_pan.pix.
4. Click Open.

Both files are displayed in the view area and are listed in the Files tree.

You will now access the Algorithm Librarian to apply the FUSE algorithm to the 
panchromatic and multispectral dataset from Toronto, Ontario that you just opened 
in Focus.

To open the FUSE algorithm:
1. From the Tools menu, select the Algorithm Librarian.

The Select Algorithm window opens.

Figure 4.9                     
Select Algorithm Panel

2. Expand the Image Processing folder.
3. In the Image Processing category, expand the Data Fusion folder.

A list of algorithms is displayed.
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Figure 4.10                 
FUSE Algorithm in the 
Algorithm Librarian

4. Select the FUSE algorithm and double-click or click Open.
The FUSE Module Control Panel opens.

Figure 4.11                 
FUSE Module Control 
Panel

The FUSE image fusion algorithm has four input ports; the Intensity Layer and the 
Red, Green and Blue Layers. You will now configure the Input Ports.
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To select the Intensity Layer:
1. In the Input Ports section, expand the Intensity Layer input port.
2. Expand the Files tree.
3. Expand the toronto_qb_pan.pix file.
4. Select the check box beside the Panchromatic band.

A check mark appears in the box and the Intensity Layer input node turns 
green.

5. Collapse the Intensity Layer input port.

To select the Red Layer:
1. Expand the Red Layer input port.
2. Expand the Files tree.
3. Expand the toronto_qb_ms.pix file.
4. Select the check box beside Band 3.

A check mark appears in the box and the Red Layer input node turns green.

5. Collapse the Red Layer input port.

To select the Green Layer:
1. Expand the Green Layer input port.
2. Expand the Files tree.
3. Expand the toronto_qb_ms.pix file.
4. Select the check box beside Band 2.

A check mark appears in the box and the Green Layer input node turns green.

5. Collapse the Green Layer input port.

To select the Blue Layer:
1. Expand the Blue Layer input port.
2. Expand the Files tree.
3. Expand the toronto_qb_ms.pix file.
4. Select the check box beside Band 1.

A check mark appears in the box and the Blue Layer input node turns green.

5. Collapse the Blue Layer input port.

The input layers have now been selected for the FUSE fusion algorithm.

Next you will configure the Output Ports. In the Output Ports section, the Viewer-
RGB option is selected by default. You will leave the Viewer-RGB option selected 
to compare the results to the original image and also specify an output file to store 
the results.
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To configure the Output Ports:
1. In the Output Ports section, make sure the Viewer-RGB option is selected.
2. Select the Untitled.pix option.

A check mark appears in the box.

3. Right-click the text box containing the path to the Untitled.pix file and select 
Browse.

4. Locate the GEO Data folder.
5. For the File name, type toronto_qb_fuse.pix and click Save.

The path and file name are updated in the FUSE Module Control Panel.

Tip
If a path for the output file is not specified, the file is saved in the user folder.

Before you run the FUSE algorithm, you will set the input parameters.

To set the Input Parameters and run FUSE:
1. In the FUSE Module Control Panel, click the Input Params 1 tab.

Parameters specific to this algorithm are listed.

Figure 4.12                 
FUSE Input Parameters
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2. For the Resample Mode, select Cubic.
This is the resampling method applied to the input RGB image.

3. For the IHS model, select Cylinder.
This is the color model used to convert from RGB to IHS and from IHS back 
to RGB.

4. Click Run.
A Progress Monitor opens on your desktop. When the algorithm has finished 
executing, the new image is displayed in the Focus view area and the file is 
listed in the Files tree.

Tip
When visually comparing the fused image to the original images, it is important 
to display the same band combinations and to apply the same enhancement 
to all images.

To change the band combination for the original data:
1. In the Maps tree, select the toronto_qb_ms.pix RGB layer.

This becomes the active layer.

2. From the Layer menu, select the RGB Mapper.
3. Change the band combination of the original toronto_qb_ms.pix RGB layer 

so it displays channels 3, 2, 1 as RGB.
4. Apply the same enhancement to both the original RGB layer and the fused 

RGB layer.

You can switch back and forth between the fused image and the original images for 
a visual comparison by dragging the toronto_qb_fuse.pix file up and down in the 
Maps tree or by turning it on and off. Another way of comparing the images is by 
using the Visualization Tools.

Along with visual comparison, it is often useful to compare the histograms of the 
fused image to the histograms of the original images. This gives you information 
about the spectral quality of the fused product.

To view image histograms:
1. In the Maps tree, right-click the toronto_qb_fuse.pix file and select 

Histograms.
The Multi Histogram Display window opens.

2. Click the histogram at the top.
The Histogram with Statistics dialog box opens displaying information for 
channel one, the red band.
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Figure 4.13                 
Histogram information for 
the red band after FUSE

3. Repeat steps 1 to 3 to display the histograms for toronto_qb_ms.pix.

In comparing the statistics for the individual channels of data, you will notice there 
is quite a difference between the fused image and the original multispectral image.

In the next lesson, you will perform image fusion using the PANSHARP algorithm. 
This fusion technique tends to produce superior sharpening results while 
preserving the spectral characteristics.

In this lesson you:

• Set up and performed image fusion using the FUSE algorithm

• Compared image histograms
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Lesson 4.4 Pansharpening Imagery

In this lesson you will:

• Set up and run the PANSHARP algorithm

PANSHARP PANSHARP applies the automatic image fusion algorithm to fuse a high-resolution 
panchromatic image with a multispectral image, creating a high-resolution color 
image. This technique is often referred to as pan-sharpening. It is an approach 
based on least squares developed to best approximate the grey value relationship 
between the original multispectral, panchromatic and the fused images to achieve 
a best color representation.

The power of PANSHARP lies in the simplicity of its algorithm and its versatility. It 
works with any image data type - 8-bit unsigned, 16-bit signed/unsigned, 32-bit 
floating point and is computationally efficient. It can also fuse images acquired 
simultaneously by the same sensor or use images from different sensors.

A very important aspect of image fusion algorithms is ensuring good co-registration 
of the input panchromatic and multispectral image data. This problem becomes 
more pronounced with high resolution sensors as IKONOS or QuickBird. A single 
pixel offset between the high resolution panchromatic image data and the low 
resolution multispectral image data results in colour shifts clearly visible in the pan-
sharpened imagery. Thus, a preprocessing step such as geometric correction or 
orthorectification, may be required before pan-sharpening the multispectral image 
data.

For best results, the input reference image channels have to be selected in such a 
way that the multispectral bands cover as close as possible the frequency range of 
the high resolution panchromatic image.

Due to the lack of sufficient colour information in low resolution multispectral 
imagery, it is recommended that the ratio of resolutions between the images do not 
exceed 5:1.
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You will now access the Algorithm Librarian to apply the PANSHARP algorithm 
to the toronto_qb_pan.pix and toronto_qb_ms.pix files that should be open in your 
Focus view area.

To open the PANSHARP algorithm:
• From the Algorithm Librarian, double-click PANSHARP.

The PANSHARP Module Control Panel opens.

Figure 4.14       
PANSHARP Module 
Control Panel

The PANSHARP fusion algorithm has three input ports; the Input Multispectral 
Image Channels and the Panchromatic Image Channel, which are mandatory, and 
the Reference Image Channels, which is an optional input. You will now configure 
the input ports.

Note
The Reference Image Channels must be specified unless the multispectral and 
panchromatic files contain wavelength metadata.
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To select the Input Multispectral Image Channels:
1. In the Input Ports section, expand the Input Multispectral Image Channels 

input port.
2. Expand the toronto_qb_ms.pix file.
3. Select all four Bands of QuickBird data.

A check mark appears in each box and the Input Multispectral Image 
Channels input node turns green.

4. Collapse the Input Multispectral Image Channels input port.

To select the Reference Image Channels:
1. Expand the Reference Image Channels input port.
2. Expand the toronto_qb_ms.pix file.
3. Select all four Bands of QuickBird data.

A check mark appears in each box.

4. Collapse the Reference Image Channels input port.

Note
The Reference Image Channels span the same wavelength response range as 
the panchromatic image layer specified for the Input Panchromatic Image input 
port. The reference channels used vary from sensor to sensor.

To select the Panchromatic Image Channel:
1. Expand the Panchromatic Image Channel input port.
2. Expand the toronto_qb_pan.pix file.
3. Select the Panchromatic Band.

A check mark appears in the box.

4. Collapse the Panchromatic Image Channel input port.

The input images have now been selected for the PANSHARP fusion algorithm.

Next you will configure the Output Ports. In the Output Ports section, the Viewer-
RGB option is selected by default. You will leave the Viewer-RGB option selected 
to compare the results to the original image and also specify an output file to store 
the results.
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To configure the Output Ports:
1. In the Output Ports section, make sure the Viewer-RGB option is selected.
2. Select the Untitled.pix option.

A check mark appears in the box.

3. Right-click the text box containing the path to the Untitled.pix file and select 
Browse.

4. Locate the GEO Data folder.
5. For the File name, type toronto_qb_pansharp.pix and click Save.

The path and file name are updated in the PANSHARP Module Control 
Panel.

Tip
If a path for the output file is not specified, the file is saved in the user folder.

Figure 4.15       
PANSHARP Module 
Control Panel Input Ports

Before you run the PANSHARP algorithm, you will set the input parameters.
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To set the Input Parameters and run PANSHARP:
1. In the PANSHARP Module Control Panel, click the Input Params 1 tab.
2. For the Enhanced Pansharpening, select Yes.

This applies a high-pass filter to enhance the visual results.

3. Click Run.

A Progress Monitor opens on your desktop. When the algorithm has finished 
executing the new image displayed in the Focus view area and the file is listed 
in the Files tree.

Tip
When visually comparing the fused image to the original images, it is important 
to display the same band combinations and to apply the same enhancement 
to all images.

To change the band combination for the PANSHARP layer:
1. In the Maps tree, select the toronto_qb_pansharp.pix RGB layer.

This becomes the active layer.

2. From the Layer menu, select the RGB Mapper.
3. Change the band combination of the toronto_qb_pansharp.pix RGB layer so it 

displays channels 3, 2, 1 as RGB.
4. Apply the same enhancement to all RGB layers.

You can switch back and forth between the pansharpened image and the original 
images for a visual comparison by dragging the toronto_qb_pansharp.pix file up 
and down in the Maps tree or by turning it on and off. Another way of comparing 
the images is by using the Visualization Tools.

Along with visual comparison, it is often useful to compare the histograms of the 
pansharpened image to the histograms of the original images. This gives you 
information about the spectral quality of the pansharpened product.

To view image histograms:
1. In the Maps tree, right-click the toronto_qb_pansharp.pix file and select 

Histograms.
The Multi Histogram Display window opens.

2. Click the histogram at the top.
The Histogram with Statistics dialog box opens displaying information for 
channel three, the red band.
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Figure 4.16                 
Histogram information for 
the red band after 
PANSHARP

3. Repeat steps 1 to 3 to display the histograms for toronto_qb_ms.pix.

In comparing the statistics for the individual channels of data, you will notice there 
is very little difference between the statistics for the pansharpened image and the 
original multispectral image.  The spectral characteristics of the original 
multispectral data were preserved in the resulting high resolution color imagery.

In this lesson you:

• Set up and ran the PANSHARP algorithm
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Module

 5 
Vector Processing with 
Focus

Module 5 has Three Lessons:

Lesson 5.1     Viewing Vector Data in Focus

Lesson 5.2     Digitizing and Editing Vectors

Lesson 5.3     Managing Vector Attributes

Vector Data In addition to support for raster image data, Geomatica Focus provides a 
variety of tools for vector data collection and analysis. While raster data’s grid-
cell structure is most useful for capturing continuous features (such as 
elevation, soil type, or temperature), vector data uses points, lines and 
polygons to represent spatial data (such as landmarks, road networks, or 
political boundaries). Vector data has advantages related to precision in 
graphics, traditional cartography, and data volume, while raster data is more 
advantageous for computation, update, and use in continuous space. By 
supporting both raster and vector data, Geomatica Focus can provide an 
extremely wide array of applications for geospatial data processing.

In this module, you will explore several typical tasks in vector data processing 
with Focus: loading and viewing vector layers, editing existing vectors, and 
examining and editing vector attributes.
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Lesson 5.1 Viewing Vector Data in Focus

In this lesson you will:

• Load and view a vector layer 

• Examine attributes using the Attribute Manager

• Select shapes in a vector layer

Working with 
Vector Layers 

Geographic features and their attributed data are stored in layers. Each layer of 
data can either represent a single set of geographic information such as 
hydrography, or a combination of information features such as road networks. Data 
layers can be displayed on-screen, and can consist of lines, polygons, and symbols 
that represent your project information. When you want to work with a layer, you 
must make it active by selecting it in the Maps tree.

For this lesson, you will begin by starting a new project in Focus.

To start a new project:
1. From the File menu, select New Project.

A window opens asking if you would like to save project changes.

2. Click No.
A new project opens.

To load a vector layer in Focus:
• From the GEO Data folder, open the file railroad.pix.

The Railroads vector layer from the railroad.pix file is displayed in the viewer 
and is listed in the Maps tree. Because this file only contains one vector layer, 
it is the default layer loaded into the Focus view area.

Tip
You can also load a vector layer using the Add Layer Wizard to select a specific 
layer to load. Alternatively you can load a vector layer from the Files tree by 
right-clicking a vector layer and clicking View.
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Focus uses three types of RSTs: Default, Direct, and Indirect.

Direct and indirect RSTs will be discussed in further detail in the intermediate 
course, Geomatica II. You will now change the default representation of the 
railroads vector layer.

When you open a vector layer, a default representation is applied to the layer. The 
default representation is set in the Options dialog box and remains a property of the 
layer while the layer is open.

To change the default display color:
1. In the Maps tree, right-click the Railroads vector layer and select Color.
2. Select the color you wish to use to display the vector layer.

The change in color is only applicable to the current session. When you open the 
layers in a new session, it will be displayed using the settings in the Options dialog 
box.

Examining 
Shape 
Attributes

The Attribute Manager displays attribute data associated with a vector layer. Each 
record in the Attribute Manager represents a shape in the layer. Each shape is 
described by a number of attributes. You can view the records individually or in a 
table. In the table, each row records all attributes for a shape. Each column holds 
values for an attribute. 

To open the Attribute Manager for a vector layer: 
• In the Maps or Files tree, right-click the Railroads vector layer and select 

Attribute Manager.
The Attribute Manager opens.

Figure 5.1                      
Attribute Manager
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The Attribute Manager shows the attributes of the vector layer you selected. In the 
Attribute Manager, you are able to select vectors, find and replace vector attributes, 
customize table definitions, set preferences, search for records using query by 
example, add records, sort records, add fields, compute attributes, join tables, and 
aggregate attributes.

To select an individual vector:
1. From the Editing toolbar, click the Selection Tools arrow and select 

Individual.

Figure 5.2          
Selection Tools

2. Click a shape in the view area.
The shape is highlighted in green.

When a shape is selected in the view area, its record is also selected in the Attribute 
Manager. This allows you to examine the attributes of an individual shape. You can 
also select a record in the Attribute Manager and the corresponding shape is 
selected in the view area.

To clear a selected shape:
• In the Maps tree, right-click the vector layer and click Unselect all shapes.

To select multiple shapes:
1. Click the Selection Tools arrow and select Area.
2. Click in the view area for each vertex you want to include in the area.
3. Double-click the last vertex.

All shapes inside or touching the polygon are selected.

Tip
If you want to add more shapes to your selection, press Shift and digitize 
another polygon.
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Figure 5.3          
Selecting Multiple 
Shapes

Statistics for the selected shapes are displayed at the bottom of the Attribute 
Manager. These summary statistics are listed for each attribute in the table.

Figure 5.4          
Statistics for selected 
shapes

In this lesson you:

• Loaded and viewed a vector layer

• Examined attributes using the Attribute Manager

• Selected shapes in a vector layer
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Lesson 5.2 Digitizing and Editing Vectors

In this lesson you will:

• Digitize new vectors using the digitizing tools

• Edit vectors using the vector editing tools

Understanding 
Vectors

Vectors are a way of presenting spatial information. Instead of representing that 
information in pixels, vectors represent the information as points, lines, and 
polygons. Focus provides two main methods for presenting the vectors: 
unstructured and topological. Each method contains several vector layer types.

An unstructured layer can contain a combination of shapes. It can also be limited 
to only contain points, lines, polygons or an unconnected table.

Only lines or polygons can have topology.

Topology

Topology is a mathematical representation of the surface features of a location. 
Topology involves not only building a relationship between the shape and the 
attributes, but also a relationship between the shapes themselves. In a topological 
file, there is a spatial relationship between all vector features. Lines connect to 
each other by points, an area is defined by a series of connected lines, and lines 
are drawn in a given direction, from point to point with left and right polygons of 
defined attributes.

In a non-topological vector file, simple geometric features will load and run faster 
than topologically based features, however individual features have no relationship 
with each other. For example, mutual polygons can have duplicate arcs 
overlapping one another. An ArcView shape file is one example of a non-
topological file format. 
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In this lesson you will load a raster layer to use as a reference image for editing the 
Railroads vector layer which should still be open in your project.

To load the reference image: 
• From the GEO Data folder, open the file l7_pan.pix.

The Grayscale layer is loaded under the vector layer in the view area and is 
listed in the Maps tree.

Figure 5.5               
Vector and Raster Layers

Before you start editing existing vectors or digitizing new vectors, you will set your 
vector editing options.

Vector Editing 
Options

The controls in the Vector Editing Options are used for creating and editing 
vectors. The Vector editing option sets the units and tolerances for Search, Snap, 
and Weed vertices tolerances in either pixels, meters, or feet. By default, the 
tolerances are measured in pixels. These options also set the snap feature for 
digitizing operations.

To set Vector Editing options:
1. From the Tools menu, select Options.

The Options dialog box opens.

2. From the list on the left, select Vector editing.
The Vector editing options appear on the right.
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3. Set the Snap tolerance to 100 meters.
4. Select the Snap automatically option.

Figure 5.6                
Vector Editing Options

5. Click OK.
The Options dialog box closes and the settings are applied.

Drawing New 
Vectors

In Focus, there are several tools for digitizing new shapes into vector layers. Lines 
can be drawn to represent linear features such as roads and river networks. Points 
could identify locations where measurements have been taken in a study area. The 
polygon tool can be used to draw and fill a polygon that could be useful for 
collecting training sites in supervised classification. Regular shapes such as 
rectangles and ellipses can also be digitized in Focus. Finally, the trace tool is 
available for digitizing irregular shapes.

In this lesson you will digitize new lines on the Railroad vector layer.

To digitize a new line:
1. On the Editing toolbar, click the New Shapes arrow and select Line.
2. Zoom to the vector in the lower middle of the Focus view area.
3. Hover your cursor over the end vertex of the shape.

The end vertex of the existing shape is shown as a square inside a circle. The 
circle is the size of snap tolerance you set. This is the vertex to which your 
new line will be snapped.
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Figure 5.7                  
Snap to End vertex

4. Click the end vertex.
Your cursor is now snapped to this location.

5. Click in the view area to add a vertex along the line.
The first line segment is created.

6. Continue to add vertices until you have digitized the shape you want.
7. Double-click or press Enter to end the line.

You have now digitized a new shape in this vector layer.

Experiment with the other New Shape tools.

Editing Vectors

The Vector Editing toolbar provides a variety of tools for modifying vectors. Some 
of the changes that you make using the vector editing tools may affect the attributes 
of the shape you are editing. For example, the Merge Line/Polygon tool combines 
two shapes, including their attributes.

To open the Vector Editing toolbar:
1. Select the Railroads layer in the Maps tree.

The Vector Editing icon on the Editing toolbar is now active.

2. On the Editing toolbar, click Vector Editing.
The Vector Editing Tools toolbar opens.

3. Hover your mouse over a button on the toolbar.
A ToolTip opens displaying the name of the tool.

The following table lists the available tools.
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Table 1: Vector Editing Tools

Tool Name Description

 
Find Selects the shape and identifies the start and end 

vertices.

 
Reverse Changes line direction (not available for whole 

polygons).

 
Add Vertices Creates new vertices within a shape. 

 
Merge Line/Polygon Connects ends of lines together or combines 

polygons by removing common boundaries. 

 
Split Line/Polygon Breaks lines and polygons into separate shapes. 

 
Extend Extends the length of a vertex in a straight line.

 
Auto Merge Line Removes the start or end vertices shared between 

lines (pseudo-nodes).

 
Close Shape Automatically connects the start and end vertices of 

a line to form a polygon.

 
Mirror Tools Flips a shape horizontally or vertically to make a 

mirror image.

 
Rotation Tools Rotates a shape around an anchor.

 
Break Line/Polygon Separates overlapping shapes at their intersecting 

points.

 
Start Vertex Moves the cursor to the start vertex in a selected 

shape.

 
Previous Vertex Moves the cursor from one vertex to the previous 

vertex in a selected shape.

 
Midpoint Moves the cursor halfway between two vertices in 

the direction of the line.

 
Next Vertex Moves the cursor from one vertex to the next vertex 

in a selected shape.

 
End Vertex Moves the cursor to the end vertex in a selected 

shape.

 
Show Vertices Makes the vertices in a shape more prominent for 

better visibility.

 
Vertices Opens the Vertices dialog box and displays the 

coordinates contained in a selected shape.
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To select a vector using the Find tool: 
1. On the Vector Editing Tools toolbar, click the Find button.
2. Click a shape.

The shape is highlighted in green. The rest of the Vector Editing Toolbar now 
becomes active. The start vertex is shown as a square inside a circle. The end 
vertex is represented by a square.

To move a vertex:
1. Click the Find button and click a shape.
2. Click the Show Vertices button.
3. Drag a vertex to a new location.

The Split Line/Polygon tool cuts lines and polygons into separate shapes. This tool 
may affect the attributes of the shape you are editing. Ensure a shape is selected and 
that the start and end vertices are showing.

To split shapes:
1. On the Vector Editing Tools toolbar, click Split Line/Polygon.
2. Move the cursor to the position on the shape where you want the split to 

occur.
A target appears along the line to indicate your position. It is represented as a 
circle between vertices and as a square at vertices.

3. Click where you want to split the shape.
The shape is split at the selected position.

Note
You are not restricted to splitting the shape at an existing vertex. You can make 
a split at any point along the shape.

The Add Vertices tool creates new vertices within a selected shape.

To add new vertices to an existing vector: 
1. On the Vector Editing Tools toolbar, click Add Vertices.
2. Click on the line where you want to add the new vertex.

New vertices are added. If you want to continue a line, click the start or end 
vertex of the line and click to add a series of vertices.

The Merge Line/Polygon tool connects ends of lines or combines polygons by 
removing common boundaries.



Geomatica I - Module 5: Vector Processing with Focus

110 PCI Geomatics

To merge vectors:
1. From the Vector Editing Tool toolbar, click the Find button and select a line.
2. Click the Merge Line/Polygon button.
3. Click the start or end vertex of the selected line.
4. Click the start or end vertex of the line you wish to merge with the first line.

The two lines are merged.

Note
To merge at a location other than the start or end vertex, you need to first split 
the shape at that location and then merge the shapes.

Experiment with some of the other Vector Editing Tools.

To save edits to the vector layer:
• In the Maps tree, right-click the Railroads vector layer and select Save.

In this lesson you:

• Digitized new vectors using the digitizing tools

• Edited vectors using the vector editing tools
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Lesson 5.3 Managing Vector Attributes

In this lesson you will:

• Add new vector attributes to a file

• Query attributes by example

• Find and replace existing attributes with new attributes

Attributes Attributes are characteristics of a geographic feature (described by numbers or 
characters) typically stored in tabular format, and linked to the feature. In 
Geomatica Focus, attributes are stored in the Attribute Manager. From the 
Attribute Manager, it is possible to add new fields, query existing attributes, and do 
mathematical operations on attributes in order to generate new information.

To add new attributes in the Attribute Manager:
1. From the GEO Data folder, open lakes.shp.
2. In the Maps tree, right-click the lakes layer and select the Attribute 

Manager.
The Attribute Manager opens.

3. From the Field menu, select Add New.
The Table Definition dialog box opens and a new field is listed at the top.

Figure 5.8                 
Table Definition dialog 
box

 

4. In the Name column for the new field, type LakeSize.
5. For the Description, type Size of lakes.
6. For the Data type, select text.
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7. For the Default value, type Medium.
8. Click OK.

A Question window opens asking if you want to add the new field and save 
the layer.

9. Click OK.
The Table Definition window closes and the new field is listed in the 
Attribute Manager.

Now that a new field has been added, you will query the database in order to add 
new information in the field. With the Query by Example tool, you can create an 
expression to selects all corresponding records. An expression can be a statement 
where two attributes are connected by a relational operator to produce a result. It 
can also be two or more statements joined by an AND or OR operator.

To select records using Query by Example:
1. From the Record menu in the Attribute Manager, click Query by and then 

click Example.
The Query by Example dialog box opens.

2. In the Attributes list, select area.
The area attribute is now highlighted.

3. From the list of relational operators, select the greater than (>) operator.
4. Above the list on the right, click Attribute Values.
5. In the list of Attribute Values, scroll down and select 0.193402.

The statement is entered in the New Statement field.

6. Click Add.

Figure 5.9                 
Query By Example dialog 
box

7. Click OK.
All records that correspond to the query are selected in the Attribute Manager.
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Now that records have been selected based on a Query by Example, you will use 
Find and Replace tools to edit the LakeSize attribute.

To replace attributes in the Attribute Manager:
1. From the Edit menu, select Replace.

The Find and Replace dialog box opens.

2. In the Find what box, type Medium.
3. Click the Limit search to selected records option.

This searches only in the records you selected as a result of your query.

4. In the Replace with box, type Large.

Figure 5.10                  
The Find and Replace 
Window

5. Click Replace All.
In the LakeSize field of the Attribute Manager, the default value of Medium 
has been replaced with a value of Large for the lakes that were selected based 
on your query.

Perform another Query by Example to select small lakes. Then, replace the default 
value of Medium with a value of Small for those selected records.

In this lesson you:

• Added new vector attributes to a file

• Queried attributes by example

• Found and replaced existing attributes with new attributes
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